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1

Introduction

This manual describes PRESTO, a USB programmer and
its control software, both manufactured by ASIX.

Chapter 1 gives you ‘quick start’ instructions on how to
start working with the programmer, offers examples of its
connecting to applications and provides technical
specifications.

Chapter 2 focuses on the installation of drivers and
software updates.

Chapter 3 introduces the UP program, which is software
used for controlling all ASIX programmers. You can find
procedures there for setting up the programmer prior to
programming, for actual programming and/or verification
of devices. It also describes how to control the software
from a command line or a DLL library.

Chapter 4 presents the JTAG SVF Player software used for
programming devices with the JTAG interface using .svf/
Xxsvf files.

Chapter 5 offers tips and tricks in case of experiencing
difficulties with programming.

Abbreviations & Terms Used

HVP (High  Voltage  Programming) is a
programming mode in which a higher
voltage than the power-supply voltage is
applied to pin P in the initial phase.

ICSP (In-Circuit  Serial Programming). The
meaning of ICSP is identical with the
meaning of ISP (In System Programming) in
this manual, i.e. device programming done
inside a system.

LVP (Low  Voltage Programming) is a
programming mode in which none of the
pins has higher than the power-supply
voltage applied.

PDI Program and Debug Interface

SBW (SPY-BI-WIRE)  MSP430  microcontroller
interface

TPI Atmel Tiny Programming Interface

VCC If the text features VCC or VDD, they mean

the power-supply voltage on the VDD pin,
which can serve as either input or output
depending on the particular application.

VPP If the text features VPP, it means the
programming voltage on pin P of devices
with High Voltage Programming.

The term “file” means a file with data to be programmed
in context of this manual, in other cases a particular type
of file is specified.

A file with .hex extension means Intel-HEX file whilst a file
with .bin extension means binary file.

Page 9



2

PRESTO

2.1

2.2

Thank you for buying the PRESTO programmer made by
ASIX s.r.o. It was a wise decision. Feel free to contact our
technical support in case of any questions or doubts.

Package Content

Your PRESTO package should include:

2.3

* PRESTO programmer

* ICSPCABS8 cable

* USB cable (type A - B)

* CD-ROM with manual and drivers

e Info leaflet

Features

PRESTO is a fast USB In-System programmer suitable for
programming a range of devices such as microcontrollers,
EEPROM or Flash serial memory chips, CPLD, FPGA and
many others.

* USB 1.1 (USB 2.0 compatible) interface, programmer
powered via USB

* 3 MHz in/out

* synchronous programming, JTAG support
e programming voltage from 2.7 Vto 5.5V
» feeds applications with 5V

* overcurrent protection on VDD and VPP sources

* overvoltage protection on VDD pin
* GO button for quick function selection

* more than one simultaneously running programmer per
PC, command line support, support for Windows
messages and for DLL

* Windows XP or later, Linux (Wine)

e compact

Quick Start

Please install the drivers and the UP software prior to the
first use of PRESTO.

2.3.1 Windows

Administrator rights are required to run the software
for the first time.

Start with installing the UP program. Its installer installs
the USB driver for PRESTO, too. You can find the installer
on the supplied CD-ROM or on the web (the preferred
option).

Once the installation is complete, connect the PRESTO
programmer to your computer.

The driver contained in the UP installer is intended for
Windows 7 and later. For older Windows operating system
versions the driver has to be downloaded from
www.asix.net, from download section of the programmer
and unpacked somewhere. After the programmer has
been connected, the operating system asks for the driver.
In "Found New Hardware" dialog the path to the
unpacked driver has to be set.

The green ON-LINE LED should turn on after a few
moments and the Windows Device Manager should
present the programmer as correctly installed.
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2.4

2.3.2 Linux

The programmer can be operated under Wine in Linux.
Please find detailed installation instructions at http://
www.asix.net/supp_linux.htm

Use

PRESTO is a fast USB programmer suitable for
programming of a range of devices such as
microcontrollers, EEPROM or Flash serial memory chips,
CPLD, FPGA and many others. It is equipped with
overcurrent protection at the VDD and VPP sources and
with overvoltage protection at the VDD pin.

The programmer is powered via USB. It can feed the
application to be programmed with a voltage of 5V or it
can utilize an external application’s voltage of 2.7 V to
5.5 V during programming.

The programmer may run under Windows XP or later or
under Linux in Wine.

2.4.1 Numerous Supported
Devices

The list of supported devices includes:

* Microchip PIC microcontrollers - devices with serial
programming, which include all PIC and dsPIC devices
with the exception of several obsolete types.

* Atmel AVR microcontrollers - all devices supporting
"SPI Low Voltage Serial Downloading" such as ATtiny12,
AT90S8535 or ATmegal28.

* Atmel ATxmega microcontrollers - devices
programmable via JTAG interface such as
ATxmegal28Al.

¢« Atmel AVR32 microcontrollers - AT32UC3A1256, for
example.

* Atmel 8051 microcontrollers - devices that support ISP
programming such as AT8958253, AT89LP4052,
AT89LP216 or AT89S2051.

* Texas Instruments microcontrollers - 16-bit MSP430,
CC430 (fuse programming is not supported for these
families) and CCxxxx.

* Cypress - PSoC microcontrollers.

* Serial EEPROM and Flash memory chips - 12C
(24LCxx), Microwire (93LCxx) and SPI (25Cxx).

» Devices with JTAG interface, for which an SVF or an
XSVF file can be created. These include CPLD (such as
Xilinx XC95xx and CoolRunner), configuration memory
for FPGA (such as Xilinx XC18Vxx and XCFxxS),
microcontrollers (such as ATmegal28) and others.

This, however, is not an exhausting list of possibilities.
Additional types are regularly supplemented in response
to customers’ interest. New software versions are
downloadable from the Internet for free.

2.4.2 USB Connection

PRESTO is controlled and powered through a USB port. It
communicates in the Full-Speed mode and works with a
USB 2.0 port or a USB 1.1 port. This means that
connecting the programmer is fast and easy, requiring
only a single cable.

2.4.3 Programming of
Placed Devices

ISP (In-System Programming) or the special ICSP (In-
Circuit Serial Programming) for the PIC microcontrollers is
currently replacing the traditional method in which
devices were first programmed and only then placed on a
PCB (printed circuit board). Thanks to ISP even SMD
devices with an extremely narrowly spaced pins can
easily be programmed and their firmware upgraded in
already assembled and finished devices.
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2.4.4 Programming of
Autonomous Devices

Those who still need to program autonomous devices, i.e.
devices not yet placed on a PCB can use the ISP2ZIF
adapter featuring a ZIF (zero insertion force) socket.

2.4.5 Programming
Interface

Devices to be programmed are connected through a 8-pin
ISP connector, which is backward compatible with the
ICSP connector for PIC microcontrollers.

2.4.6 Power Supply From
Application

The VDD output can serve as an input using the power
from the application for feeding the output buffers with a
voltage from 2.7 V to 5.5V or it can become an output
and as such to provide voltage for the application.
PRESTO can power applications with 5 V voltage.

PRESTO detects three levels of external power supply
voltage: 3V, 5V and overvoltage.

PRESTO includes an overcurrent protection at pins P and
VDD.

The voltage range can be extend by two optional
adapters (HPR3V3, HPR1V2).

HPR3V3 is an optional accessory for PRESTO by which
PRESTO can power applications with 3.3 V voltage.

HPR1V2 is an optional accessory for PRESTO which
extends input voltage of VDD pin in power from
application mode from 1.2 V to 3.3 V.

2.4.7 User Interface

The programmer status is clearly indicated by two LEDs.
ON-LINE (green LED) informs of connecting to USB while
ACTIVE (yellow LED) signals an activity of the
programming interface.

The GO button significantly increases the operator's
comfort in repeated programming. It starts programming
or other user-defined commands.

2.4.8 Software

The UP program is a basic software tool for working with
PRESTO, also compatible with the FORTE programmer.

Apart from standard commands, UP provides numerous
above-standard functions, which broaden the
programmer’s applications and simplify its operation.
These include the possibility to define projects, existence
of adjustable parameters when running from the
command line providing for unattended programmer
operation in routine programming, environment
personalization incl. keyboard shortcuts, automatic
generation of serial numbers, etc.

UP has been developed for Windows XP or later. It also
works under Linux (through Wine).

Modified drivers developed by FTDI are used for
communication through USB.

Devices with the JTAG interface, for which an SVF or an
XSVF file can be created, can be programmed by means
of the JTAG SVF Player software.

The voltage at the VDD pin is permanently displayed in
UP for greater comfort and for monitoring of the
operation. The reset signal is conveniently controlled by a
single button.
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2.4.9 Debugging

PRESTO provides user with support for debugging ARM
microcontrollers through OpenOCD which is an open
source debugging system originally developed by
Dominic Rath. OpenOCD uses GDB for access to debug
functions. User can communicate with OpenOCD via a
command line and telnet.

The revision 717 of OpenOCD, which can be found on our
website in a program package together with the ARMINE
program, is supported officially.

2.5

Controls and
Connectors

-

Fig.2: The PRESTO programmer

PRESTO features two LEDs, a button, a connector for
linking to USB and a programming connector.

2.5.1 Programming
Connector

The programming connector is a 8 way single row plug
with pin No. 2 (in standard numbering) missing. Spacing
between pins is 2.54 mm.
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Fig.3: Programming connector

Pin Name |Type Description
P1 VPP I/O, VPP |signal input/output or VPP output
P2 key
P3 VDD PWR power input/output
P4 GND PWR signal grounding
P5 DATA/ |I/O signal input/output
MOSI
P6 CLOCK O signal output
P7 MISO | signal input
P8 LVvP I/O signal input/output

Table 1: programming connector

2.5.2 GO Button

his button simplifies work with the application being
programmed. It triggers device programming or another
pre-programmed function. For further information on
settings see Setting the GO Button

2.5.3 LED Indicators
ON-LINE

The green LED informs you that PRESTO is connected to a
computer and that the computer and the programmer
“understand each other”, i.e. drivers are installed and
work correctly.

In Linux, the green LED turns on upon connecting the
programmer to a PC even before the driver is correctly
installed.

ACTIVE

The yellow LED informs you that there is ongoing
communication between the programmer and a device.

2.5.4 USB Connector

A standard USB (type B) connector is provided for
connecting to a computer. The programmer uses the
USB Full-Speed interface for communication.
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2.6

Connecting to
Application

The programmer should be connected to an application to
be programmed with an ICSPCAB8 which is designed for
2.54 mm spacing.

Fig.4: ICSPCAB8

2.6.1 Custom-made
Connecting Cable

Should an application to be programmed have a non-
compatible type of connector for Ilinking to the
programmer, the customer can make his/her own
programming cable. Its length should not exceed 15 cm.

The following table lists markings of connectors by FCI
Electronics suitable for making a custom cable. Of course,
it is possible to use any similar ones:

FCI marking Description
65039-036LF housing, 1 pin
65039-029LF housing, 1 x 8 pins
47217-000LF pin

Table 2: ICSP cable - material list

A cable with a cross-section between 0.1 and 0.3 mm?
may be used for making the custom connecting cable.

2.6.2 Programming in ZIF
Socket

If programming of autonomous device is required, i.e.
those that are only later connected to an application, it is
possible by means of our optional ISP2ZIF accessory.

Fig.5: ISP2ZIF

ISP2ZIF consists of a zero insertion force (=ZIF) socket
and an ICSP connector for connecting to the programmer,
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which can also provide voltage for feeding the program
circuitry.

2.6.3 Connecting
Procedure

The correct procedure for connecting the programmer:
first connect PRESTO to the target application, then
connect PRESTO to the USB and finally turn on the
application’s power supply.

Please make sure that the GND of the application, the
programmer and the USB are interconnected before
signals and the power are applied.

Important warning
If an application is powered by a switched

power source or is not grounded, a significant
voltage difference may appear between the
programmer’s ground and the application’s

ground. This could damage the programmer.

The simplest way of connecting the GND prior to the
other signals is to ground the application before
connecting it to the programmer. This can, for example,
be achieved by making the GND pin of the application’s
ICSP connector longer than the other pins. It will make
sure that both grounds are interconnected first.

Pin AVR AVR TPI 8051 JTAG

Pl RESET RESET RESET USR

P2

P3 VCC VCC VCC VDD

P4 GND GND GND GND

P5 MOSI TPIDATA MOSI TDI

P6 SCK TPICLK SCK TCK

P7 MISO MISO TDO

P8 SS TMS
Table 3: Connection list No.1

Pin PIC MSP430 MSP430 TI COXxxx

SBW

Pl MCLR TEST RESET

P2

P3 VDD VCC VCC VDD

P4 VSS VSS VSS GND

P5 PGD TDI SWBTDIO Debug data

P6 PGC TCK SWBTCK Debug clock

P7 TDO

P8 LVP T™MS

Table 4: Connection list No.2
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Pin PSoC 12C SPI Microwire
P1 XRST CS CS

P2

P3 VDD VDD VDD VDD
P4 VSS GND GND GND
P5 ISSP-data SDA S| DI

P6 | ISSP-SCLK SCL SCK CLK

P7 SO DO

P8 ORG (PRE)

Table 5: Connection list No.3

2.6.4 Connection Examples

The following text presents examples of connections
between PRESTO and the device being programmed. We
use a notation according to the manufacturer datasheet
of each particular device.

PIC Microcontrollers

P1 - VPP (13V)
P2 —0

- DATA/MOS| ———=
-Clock—"_____*
P7 - MISO
P8 - LVP

Fig.6: PIC microcontroller

1)Not all PIC microcontrollers have the PGM pin. The PGM
pin can be connected to programmer’s L pin, to VSS via
a pull-down resistor (for HVP programming) or to VDD
via a pull-up resistor (for LVP programming).

2)The whole device must be erased before programming
if code/main memory protection (CP) or data memory
protection (CPD) is active.

3)Some PIC devices cannot be erased with CP or CPD
active being powered by voltage less than 5 V.

4)If a microcontroller has more than one power-supply
VDD or VSS pin, all of them must be connected
including the AVDD and AVSS pins.

5)PIC microcontrollers which require 3 V or lower power
supply must be fed from external power supply
because PRESTO can only provide 5 V voltage.

6) Some PIC microcontrollers require voltage less than
13 V on the MCLR pin while the programmer can only
set 13 V voltage level on VPP. If such device has been
selected in UP, a warning message is displayed. It is
recommended to limit voltage on the MCLR pin by an
external circuit (a potential divider or a Zener diode
and a resistor).

7)If the LVP mode is used, it is recommended to check
whether the LVP fuse is still set after erasing the part.

8)Programming of PIC32 devices is supported by means
of the ICSP interface only with external 3 V power

supply.

9)Devices with an ICPORT fuse must have the dedicated
ICSP port off for LVP programming.

10) PIC24 and dsPIC33 devices may be programmed
using PE (Programming Executive) or using the
standard method. Programming by means of PE is
usually faster.

11) Programming of some new PIC microcontrollers in the
HVP mode can cause that a warning message
indicating overcurrent on VPP appears. If that message
does not indicate a real fault it could be caused by
different technology which has been used by Microchip
for producing new devices, although they are from
pristine families. These devices have slightly different
parameters. It could be solved by connecting capacitor
of 1 nF between the VPP pin and GND and resistor of
10 Q in serial with VPP signal if the fault persists.
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AVR Microcontrollers

VPP RESET
S VDD VCC
T GND GND
P5 - DATA/MOS| —= DATA M |
R T .
P - LVP MISO MISO

Fig.7: AVR microcontroller

1)A source of the clock signal, which is set in the device
or which will be set by fuses during programming must
be connected to the device. A crystal must be
connected if set up as the clock source.

2)Device fuses have been set up by the producer to the
internal oscillator with a frequency of 1 MHz. In the
initial programming, the device should be programmed
with “Oscillator frequency” set up at “>750 kHz"” or
lower in the “PRESTO programmer settings”
window.

3)Not all AVR microcontrollers allow use of a crystal
(e.g. ATtiny13, ATtiny15).

4) After the device fuses are correctly set up, right-click
(i.e. using the right mouse button) inside the
Configuration window and choose Learn fuses. This
saves the fuses in the up.ini file or in the project if used.
This is necessary due to the fact that .hex files for AVR
microcontrollers themselves do not contain
configuration fuses. If a device is programmed from the
command line, a .ppr project file containing saved fuses
needs to be used.

5)Ticking the Open file with data memory
automatically option in the File menu loads data for
the data memory simultaneously with the code/main
memory data.

6)Use the EESAVE fuse if preservation of data memory is
required. If the EESAVE is active, choose Program all
except data memory for programming, otherwise a
warning appears at this place (blank check of data
memory).

7)HPR3V3 is an optional accessory for programming AVR
microcontrollers which reguire 3.3 V voltage with
PRESTO internal 5 V power supply.

8)HPRAVR is an optional accessory for programming AVR
microcontrollers in applications with the ISP10PIN
standard connector on the device's side.

9)Some AVR devices have their ISP interface provided at
different pins than the SPI interface. Further
information can be found in the device data sheet (in
the Serial Downloading section).

AVR with TPI Interface (e.q.
ATtiny10)

VPP RESET
P1- VPP (13V)

P2 —a VDD Ve
e ——~—— GND GND
P5 - DATA/MOS| —=

5= DATAN 2 DATA TPIDATA
:; B K«Ilgo — . CLOCK TPICLK

Fig.8: AVR microcontroller, TPI interface

1) These microcontrollers require voltage 12 V on the
RESET pin during programming in the HVP mode while
the programmer can only set 13 V voltage level on VPP.
Therefore it is necessary to limit voltage on the RESET
pin by an external circuit. There is no need of any
external circuit for the LVP mode which is preferred.
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Atmel 8051

VPP RESET

P1- VPP (13V)

P2 0 VDD VCC
438 Sp— G GND
P5 - DATA/MOS| ————= DATA MOSI

Pé - CLOCK—————
P7-MISO — & CLOCK SCK

P8 - LVP

MISO MISO
LVP sSsh

Fig.9: Atmel 8051 microcontroller

1)The SS pin must be connected only for AT89LP2052 /
4052 /213 /214 /216 /428 /828 /6440 /51RD2/
51ED2 /51ID2 /51RB2 / 51RC2 / 51IC2.

2)AT89LP213, AT89LP214 and AT89LP216 have the
inverse reset logic. Thus an appropriate resistor must
be pulled-up to VCC.

3)PRESTO can not program devices containing the letter
“C” in their name, however, it supports devices with “S”
in their name, of which some are compatible with the
“C” types. For example, AT89C2051 is not supported,
but AT8952051 is.

4)The software assumes that while programming
AT89LP52, the device’s POL pin is in logical 1. If POL is
in logical 0, the Inverse RESET option should be
activated in the program. AT89LP51RD2, AT89LP51ED?2,
AT89LP51ID2, AT89LP51RB2, AT89LP51RC2 and
AT89LP51IC2 have the inverse reset logic, therefore the
software assumes the POL pin in logical 0.

Cypress PSoC

VPP XRST 1
P1- VPP (13V)
2 a VDD VDD
:i : \(;?1?) — . GND VSS
P5 - DATA/MOS| —= T
Pé - CLOCK——————= DATA ISSP-SDATA
P7-MiSO — "3 CLOCK ISSP-SCLK

P8 - LVP

Fig.10: Cypress PsoC microcontroller

1)The way of entering in the programming mode should
be set in the PRESTO programmer settings window.
Devices without an XRST pin can only use initialization
through the power-on reset (by power supply). Devices
with an XRST pin may use both methods, but the
method using the reset signal for initialization is better
as it can be used in combination with an external power
supply.

2)Algorithm programming in the PRESTO
programmer settings window should be set in
accordance with the power supply cable used.
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MSP430 with TEST pin without
SBW interface

VPP TEST"
R VDD vCC
e ——~—— GND VSS
P5 - DATA/MOS| —=
 — T e
P - Ve MISO TDO
LVP ™S

RST
47k

Fig.11: MSP430 microcontroller, TEST pin, without SBW
1)Not all MSP430 microcontrollers have the TEST pin.

2)This interconnection can be used with e.g.
MSP430F1xx, MSP430F4xx, MSP430F21x1, but not with
MSP430F20xx or MSP430F22xx.

3)If the oscillator calibration values are saved in the
information memory and this memory is not going to be
re-programmed (erased) during programming, the
device should be programmed with the Cal Int. RC
(=calibrated internal RC oscillator) option selected in
the PRESTO programmer settings window. In the
other cases Not Cal Int. RC (=not calibrated internal
RC oscillator) should be selected.

4)The safety fuse on the JTAG interface cannot be blown
by the PRESTO programmer.

5)The HPR3V3 adapter should be used for feeding these
microcontrollers (without the SBW interface) from
PRESTO internal 5 V power supply.

MSP430 / CC430 with SBW
interface

P1- VPP (13V)
2 ~——a 47k

P
P3-VDD — [:l'

P4 - GND . VDD VCC
P5 - DATA/MOS| ———= GND VSS

P6-CLOCK~——*

P7-MISO — 3 DATA SBWTDIO

P8 - LVP

CLOCK SBWTCK

Fig.12: MSP430 / CC430 microcontroller, SBW

1)Microcontrollers with SBW interface could be
programmed only through this interface. It concerns
e.g. MSP430F20xx, MSP430F22xx or MSP430F5xxx.

2)If the oscillator calibration values are saved in the
information memory and this memory is not going to be
re-programmed (erased) during the programming
process, the device should be programmed with the
Cal Int. RC (=calibrated internal RC oscillator) option
selected in the PRESTO programmer settings
window. In the other cases Not Cal Int. RC (=not
calibrated internal RC oscillator) should be selected.
There is no need to select the oscillator for the
MSP430F5xxx and CC430 devices.

3)The safety fuse on the JTAG interface cannot be blown
by the PRESTO programmer.

4)Speed in the PRESTO programmer settings window
should be slow down if any external capacitor is
connected to the device's reset pin.

5)The PRESTO programmer also erases the Segment A of
the information memory with the Erase Segment A
option selected.
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Tl (Chipcon) CCxxxx

VPP RESET
P1- VPP (13V)
2 = VDD VDD
:i - \é?l?) — GND GND
P5 - DATA/MOS| —=
P . CLOCK —————= DATA Debug data
P7 - MISO — CLOCK Debug clock

P8 - LVP

Fig.13: Tl (Chipcon) Ccxxxx microcontroller

12C Memory Chips

P1- VPP (13V) — 9
- P2 VDD VDD
: e —— GND GND

P5 - DATA/MOS| ————=
MX P - CLOCK————* DATA SDA
P7-MISO — o CLOCK SCL
P8 - LVP

Fig.14: 12C memory chips

1)The programmer uses an internal 2.2 kQ pull-up
resistor on the data wire (SDA) when working with an
12C device.

2)If the device to be programmed is 24LC(S)21A or
24LC(S)22A, its VCLK pin must be connected to VDD
during programming.

3)34xx02 memory chips need “high” voltage at the A0
pin for commands protecting it against SWP and CSWP
recording. The “high” voltage is generated at pin P,
which must be connected to pin A0 in this case. The
memory chip pins A0, A1 and A2 must be connected
manually according to the selected protection mode.

SPI Memory Chips

VPP #CS
Eé ’ ::va) e VDD VDD
P4.GND— & GND GND
e DATA Si
:; : w:o _— CLOCK SCK

— MISO SO

Fig.15: SPI memory chips

1)Some devices have WP, HOLD or RESET pins. All of
them must be connected to the required logic level in
such a way as not to block the communication or
device programming.

2)Different manufacturers mark the memory chips' SPI
pins with different names. Some of them are listed in
the following table:

Name on figure Atmel, SST ST
DI Sl D

DO SO Q

CLK SCK C

#CS CS,CE S

3)The HPR3V3 adapter should be used for feeding SPI
memory chips from PRESTO internal 5 V power supply.
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Microwire Memory Chips

VPP cs

R VDD VDD

R~ GND GND

P5 - DATA/MOS| —=

 — T T

P - Ve MISO DO
LVP ORG (PRE)

Fig.16: Microwire memory chips

1)Pin L determines the memory organization as either 8-
bits or 16-bits per word. The user selects the required
organization in the UP program and PRESTO then sets
this pin to the corresponding logic level. If this memory
pin is firmly connected to the correct logic level inside
the application, pin L in the programmer remains
disconnected.

2)If used in combination with the M93Sx6 memory chip,
the programmer's L pin must be connected to the
device's PRE pin to serve for selecting the protection
register.

JTAG Interface

VPP selectable
R VDD VDD
= GND GND
CihE— AT ]
P7-MISO — CLOCK TCK
Pe-Lve MISO TDO

LVP TMS

Fig.17: Components with JTAG interface

1)Pin P is configurable in the JTAG Player utility. It can be
set to keep the device in reset during programming.
This is needed for Atmega devices, for example.

2)The programmer always uses an external power-
supply voltage for SVF or XSVF file programming
by means of the JTAG Player utility.

3)ARM microcontrollers can be programmed and
debugged through JTAG interface. The ARMINE
program, which can be found on our website, serves
ARM microcontrollers programming. For more
information on ARM microcontrollers programming see
the ARMINE program help.

4)PRESTO provides user with support for debugging ARM
microcontrollers through OpenOCD which is an open
source debugging system originally developed by
Dominic Rath. OpenOCD uses GDB for access to debug
functions. User can communicate with OpenOCD via a
command line and telnet.

5)The revision 717 of OpenOCD, which can be found on
our website in a program package together with the
ARMINE program, is supported officially.

6) The HPR1V2 adapter should be used if power supply
voltage lower than 2.7 V

7)AVR32 microcontrollers are to be programmed from the
UP software through the JTAG interface. The device
must not be reset during programming.

8)ATxmega microcontrollers with the JTAG interface can
be programmed from the UP software through this
interface. Pin P is not needed for programming. The
HPR3V3 adapter should be used for feeding these
devices from PRESTO internal 5 V power supply.
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2.7

HPR Adapters
2.7.1 HPR3V3

HPR3V3 is an optional accessory to the PRESTO
programmer for programming of stand-alone 3.3V
devices as for example DataFlash Memories. The PRESTO
programmer can supply a programmed device with 5 V.
However, some devices require 3.3 V supply voltage and
3.3 V logic levels on their pins. In such case, the HPR3V3
level shifter or an external 3.3 V power supply have to be
used.

Using

The HPR3V3 level shifter can be used very simply. Plug it
directly to the pins of the PRESTO programmer (NOT to
the programmed device connector!). Pin 2 is used as a
key, so that is not possible to connect it wrong way. Now
connect the programmed device to HPR3V3 using ICSP
cable. Connection of the programmed device pins is same
as connection of the device to PRESTO.

Common connection diagram is below.

P1 - VPP (13V)
P2 —a
P3-VDD —
PA-GND—— =
ASI x P5 - DATA/MOS| ————=

Pé-ClOCK~——*
P7-MISO —" & A «
O\ ACTIVE g7 vp J B < ICSP cable

Fig.18: Use of HPR3V3

Set internal power supply for programming.

Important warning
The HPR3V3 pins are unidirectional, so this

level shifter can be used for AVR devices, SPI

Flash memories or MSP430 devices without

SBW interface, but it is not intended for PIC

devices and MSP430 devices with SBW

interface.

Never connect external voltage to the output

3.3 V supply pins!

2.7.2 HPR1V2

HPR1V2 is an optional accessory to the PRESTO
programmer for programming of the devices with supply
voltage and logical levels between 1.2 V and 3.3V as for
example Xilinx CoolRunner-Il .

The PRESTO programmer can program devices with signal
levels between 3 and 5V £ 10%, but sometimes it is
necessary to program a device with less signal levels. In
such case, the HPR1V2 level shifter must be used. The
level shifter must be used with external supply voltage
from application, it cannot be supplied from the
programmer.

Usage

Plug the HPR1V2 level shifter directly to the pins of the
PRESTO programmer (NOT to the programmed device
connector!). Pin2 is used as a key, so that is not possible
to connect it wrong way. Now connect the programmed
device to HPR1V2 using ICSP cable. Connection of the
programmed device pins is same as connection of the
device to the PRESTO. Common connection diagram is
below.
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P1- VPP (13V) — 9
P2

P5 - DATA/MOS| ———=
P6 - CLOCK

P7 - MISO
P8 - LVP

CALYdH §
" (NOILYIIVddY
TiTee? 2

NS

—ICSP cable

Fig.19: Use of HPR1V2

Important warning
he HPR1V2 pins are unidirectional, this level

shifter can be used for example with JTAG
devices, but it is not intended for devices

what need bidirectional pins like PIC
processors.

The HPR1V2 must be supplied with extemal
supply voltage from application.

Never turn on the internal supply voltage
from programmer, when the HPR1V2 is
connected!

2.7.3 HPRAVR Adapter

HPRAVR is an optional accessory for PRESTO and FORTE
programmers for programming AVR microcontrollers in
applications with the ISP10PIN standard connector on the
device's side and with the ICSPCAB8 cable on the
programmer's side. The ISP10PIN connector is typically
used on boards with microcontrollers of the AVR type
such as STK500, for example.

Use

Connect the HPRAVR adapter to the application's
connector. Make sure that pin 1 of the HPRAVR adapter is
connected to pin 1 of the ISP10PIN connector in the
application (Pin 1 is marked with a red dot at HPRAVR
while it may be marked in different ways on the

connected application - see information in the
corresponding manual).

Now interconnect the adapter and FORTE with an ICSP
cable. Pin 2 in the cable is used as the key. The following
picture illustrates a typical interconnection of the PRESTO
programmer with an application through the HPRAVR
adapter:

I

P2
@ / ON-LINE P3-vDD —
[ P4-GND——
P5 - DATA/MOS| ———=
\ MX P - CLOCK~—————* ‘
- P7-MISO — &
©NACTIVE pgyp—— " | | ICSP cable

=
3
3
>
&

P1-

S s ~
‘ ~ GO\

Fig.20: Use of HPRAVR

Important Warning
Pin No. 1 of the HPRAVR adapter is marked

with red color. Please double check the
position of the pin No. 1 in the application as
the application could be damaged if

incorrectly connected.

Mos | 1] 2| WCC

MC | 3 | 4| GHND

RST | & | 6 | GND

SCK | 7| 8| GND

MISO | 9 [ 10| GND

Fig.21: ISP10PIN, top
view
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R1

J2 MOST —— GND
1 RST J1 —
100k

2 P = R2

GND SCK — GND
4 5 6
s [ MOST -t b
6 [ ScK [ 5 10 100k
- MISO | R3
8 x BL8-10 RST — vce
S1G8W 10k

Fig.22: HPRAVR adapter diagram

2.8 Built-in Protection

The PRESTO programmer provides internal overcurrent
protection on the VPP and VDD pins and overvoltage
protection on the VDD pin.

PRESTO is able to detect overcurrent on the VPP or VDD
pin and consequently to disable these pins but only when
PRESTO is connected to a PC and the UP program has
been launched. If overvoltage on VDD pin is detected a
warning message is displayed.

All 1/Os have their 27 Q resistors for better shortage
endurance. Inputs, where it is technically possible, are
equipped with Zener diodes for better overvoltage
endurance.

Any voltage peak higher than 7.5 V or any current higher
than 20 mA on any I/O can cause damage of the
programmer.

Important warning
PRESTO must be connected to a PC and the

UP program must be launched for correct
function of internal protection.

2.9

Technical Specifications
2.9.1 Limit Values

Operating min. 0 °C max. +55 °C
temperature

Storage temperature |min. -40 °C max. +85 °C
Maximum current on [max. 370 mA

uUsB

Voltage at any pin!  [min.-0.5V max. 6.5V
Maximum current on |20 mA

I/O pin

ESD protection (HBM [+4 kV contact

model) +8 kV air

Table 6: Limit values

2.9.2 Operating
Specifications

Important Warning
Failure to respect these parameters may

damage the programmer or the connected
computer.

VDD feeding voltage supplied by|5 V
programmer

VDD feeding voltage supplied by|2.7 Vto 5.5V
application

Maximum current drawn from |100 mA
VDD

Maximum current drawn from |50 mA

VPP
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2.9.3 Declaration of

Conformity

Maximum current drawn from I/ |4 mA

O pin

Allowed input voltage on pins  |0to 5.5V

P pin output voltage 13V orlogic levels

VIL input voltage max. 0.5V

VIH input voltage min. 2.0V

VOL output voltage max. 0.44V @ VDD=4.5V
typ. 0.1V

VOH output voltage min. 3.8V @ VDD=4.5V
typ.VDD-0.1V

Resistance to short circuiting limited?

Operating system

Windows3 32/ 64-bit, Linux*

USB compatibility

USB 1.1 Full Speed

USB 2.0 compatible
USB connector type B
Dimensions 112 x 64 x 22 mm
Weight 804g
Gross weight 180g

Table 7: Operating specifications

1 Pin VPP configured as an output has a voltage +13 V
2 For more information see Built-in Protection
3 Windows XP, Windows Vista, Windows 7, Windows 8,

Windows 8.1

4 The UP software runs under Wine

Declaration of Conformity

We, manufacturer ASIX s.r.o.
Staropramenna 397/4, 150 00 Prague, Czech Republic

declare under our sole responsibility that

the product: Component programmer
type: PRESTO
using: Silicon Device In-Circuit USB Programmer

manufactured by our company is in conformity with the following standards

EN 55022 Radio disturbance characteristics - Information technology equipment
EN55022, class B Radiated Emission

EN 55024 Immunity characteristics - Information technology equipment

EN61000-4-2, class B Electrostatic Discharge
EN61000-4-3, class A Radiated Susceptibility
EN61000-4-8, class A Power Magnetic Field

following the provisions of Directive
2004/108/ES

Certificate no.: 1140044
Complementary information:

Test report no.: 302137-01/01

Issued by: Elektrotechnicky zkusebni ustav, s.p.
Pod Lisem 129, 171 02 Prague 8, Czech Republic.

The last two digits of the year in which the CE marking was affixed: 14

Place of issue: Prague

Date of issue: 2014-01-22
Manufacturer representative: RNDr. Bedrich POLA
Position: Managing Director
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PRESTO complies with the RoHS directive.

R@HS
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3

DRIVERS

3.1

This chapter deals with driver installation and updates.

Driver Installation

3.1.1 Windows Operating
Systems

The user must have administrator rights to install and run
the UP program for the first time. Standard user rights are
sufficient for further use.

PRESTO drivers are installed automatically as part of the
UP program installation.

Windows 7 and later

Start with installing the UP program. Its installer installs
the USB driver for PRESTO, too. You can find the installer
on the supplied CD-ROM or on the web (the preferred
option).

Once the installation is complete, connect the PRESTO
programmer to your computer. The green ON-LINE LED
should turn on after a few moments and the Windows
Device Manager should present the programmer as
correctly installed.

Older supported Windows
versions

The driver contained in the UP installer is intended for
Windows 7 and later. For older Windows operating system
versions the driver has to be downloaded from
www.asix.net, from download section of the programmer
and unpacked somewhere. After the programmer has
been connected, the operating system asks for the driver.
In "Found New Hardware" dialog the path to the
unpacked driver has to be set.

During the installation, the operating system will ask
whether it should install the software, which has not
passed the Microsoft compatibility test for Windows. Click
Continue Anyway.

Software Installation

L ] E The zoftware you are installing has not paszed Windows Logo
L testing to verify ity compatibility with ‘Windows XP. [Tell me why
this testing iz important. ]

Continuing your installation of this software may impair
or destabilize the cormect operation of your system
either immediately or in the future. Microsoft strongly
recommends that you stop this installation now and
contact the software vendor for software that has
passed Windows Logo testing.

Fig.23: Compatibility test dialog window

The green ON-LINE LED should turn on after a few
moments and the Windows Device Manager should
present the programmer as correctly installed.
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3.2

3.1.2 Linux

The programmer can be operated under Wine in Linux.
Please find a detailed manual at http://www.asix.net/
supp_linux.htm

Driver Updating

PRESTO communicates with the PC through a USB circuit
produced by FTDI www.ftdichip.com, which also develops
drivers for these circuits.

The latest drivers are always included in the UP
installation pack.

Drivers for the Windows operating system have been
stable for a long time and therefore no further updates
are usually needed, unless additional applications using
the FTDI circuits on the given PC so require.

However, should you need to update your driver, the
simplest way of doing so is to update the UP program.

Download the latest UP installer from the web and install
the new version without risk of losing your personalized
program setup data or data of your projects. The new
version will replace the original one.
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4

UP SOFTWARE

4.1

4.2

UP is a name for control software designed for
programmers made by ASIX. The program offers many
advanced functions and enables an operator to control
the programming process either from the software
interface or remotely from the command line utilizing
Windows messages and the DLL library. The program runs
under Windows or Linux (in Wine).

Abbreviations Used

Menu - item bold italics followed by the arrow sign - make
references to particular items in menus, names of
tabs (cards) in a particular window.

Installation

Installation is very easy. The installation program can
either be found on the CD-ROM supplied together with the
programmer or downloaded from www.asix.net. Run the
installer (UP_xxx EN.EXE, where xxx represents the
version number). There is no need to close other running
applications. The installation process takes only a few
seconds and requires you to press the Enter key a few
times. No modifications to the operating system take
place during installation, i.e. no computer restart is
needed and the program can be used immediately after
completion (by clicking its icon, for example). After the
first start, the program asks which language it should use
(English or Czech), which programmer to work with (e.g.
FORTE) and which port the programmer is connected to.

If needed, the program can be uninstalled using the Add/
Remove Programs icon in the Control Panel or manually

4.3

by deleting the corresponding directory and desktop
shortcut(s).

A previous program version (if it exists) does not have to
be removed before installing a newer version. Use of the
latest available version is recommended.

Device Programming

The following sections describe the ways of programming
devices and things to pay special attention to.

4.3.1 Programmer
Selection

Before a device can be programmed, the programmer
which will be used needs to be selected. Currently either
FORTE or PRESTO can be chosen.

Select the programmer by going to Options - Select
programmer or by double-clicking the programmer
name displayed in the top right corner of the program
window. The following dialog window opens:
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Select equipment —_—

Prograrmmer:

FORTE v| [ Test.

Port selection:

Abways use this S/MN

@) S/M 040003

Fig.24: Programmer selection

If the programmer is connected to a computer and no
other program communicates with it, its serial number
gets displayed. You can test communication with the
selected programmer by pressing the Test... button.

If the Always use this S/N choice is set, the currently
selected programmer is used even when in a loaded
project file there is defined a different programmer serial
number. Serial number defined on the CommandLine has
priority before this choice.

4.3.2 Projects

It is recommended to use projects for device programing
in UP.

Projects save all settings directly associated with
particular device programming such as device type,
required voltage, verification method, name of file
containing the programming data and many other
important pieces of information.

A new project can be created by choosing File - New
project.

This is followed by selecting a device type, a file with
programming data, settings of the device's configuration
word, applied voltage and other important parameters.

configuration word, applied voltage and other important
parameters.

Once all required selections are made, save the project by
choosing File - Save project...

An existing project can be opened by choosing File -
Open project....

4.3.3 Device Type
Selection

Select the device type by choosing Device - Select
device or by double-clicking the device name displayed
in the top right corner of the program window.

Select device L-S_:hj

Quick search:
Dievice Family Device:
[I2CEEPROM  ~ | [B4EATE v

ok LCancel

Fig.25: Device selection

A filter is available for sorting devices by families and
another one for Quick search. Just start typing an
important part of the device's name in its field. This
radically reduces the list of devices and speeds up the
whole selection process.

The Quick search filter allows use of the question mark as
a wild-card for a part of the name, for example
PIC18?20.
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4.3.4 Program settings

It is advisable to fine-tune the program behavior by
adjusting the settings to suit your particular needs. This
can be done by choosing Options - Program settings.

There is a great number of possible settings. If you are
not sure that all the settings are correct, use the Load
defaults button, which returns all the setting to the
original (default) state.

If you are updating UP to a new version, all the existing
settings will be preserved.

A detailed description of all settings can be found in
Menus, so we will pay attention to only a few important
settings for now.

Delay for VDD switching on/off
when supplied from
programmer

If you supply power to your application from the
programmer during programming and UP announces
overcurrent on VDD pin due to charging capacitors in the
application, it may be advisable to enlarge the switch on
time in Program settings... - Programming - Delay
for VDD switching on/off when supplied from
programmer. This might be necessary to give the
programmer enough time to charge the large capacitors
in the application.

At the same place it si possible to set the discharge time,
when the program announces, that the VDD was not fully
discharged.

Program settings
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wWam befare file load, when data in some editor hawe been changed
Warn, when the loaded file has not changed.

V| Ask before erasing

v | Ask before programming of OTP
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v | Ask before Code/Data Protection programming
V| Ask before differential program

v | Display fuses waming messaces

v | Except for programming: Close status window when there is no error
After programming: Close status window when there is no errar

Beep after successful finishing
v |Beep after unsuccessful finishing

Turn off all sound for UP
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Panels | Files Colors | Editars | Serial numbers | Checksum | Others
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Fig.26: Programming settings
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Production Programming
Settings

If you want to perfectly verify your production to make
sure that the device is correctly programmed, you can
use the Program settings - Programming - Verify
with two supply voltages option and to apply the
lowest and the highest voltage allowed for the device as
the limits. Some manufacturers recommend this option
for the production programming. However, it is only
available if the application is supplied with power from
FORTE.

Program settings - Panels - Show mass production
counter in status bar could be a useful tool visibly
monitoring numbers of successfully and unsuccessfully
programmed devices. The counter can be reset in Device
- Program - Mass production - Counter reset.

Program settings - Serial numbers - Log to file can
be used as another convenient assistant. With this option
selected, information on the programming progress of
individual devices gets recorded (logged) in a selected
file.

If you wish to automatically include the serial number
during production programming, you have a great range
of possibilities concerning what the number should look
like and where it should be positioned in the memory. All
serial number settings can be found on the Serial
numbers tab.

For further information on serial numbers see Serial
Numbers.

Settings for Programming
During Development

If you are frequently changing the content of the
programming data such as during application
development, for example, you can simplify your work by
using the GO button, which typically serves for

programming and verification of the whole memory
content. The function of this button is programmable and
can be set up under the Options -» Key shortcuts menu
in the GO button section.

The use of the GO button for programming should be
accompanied by Options - Program settings -
Programming - Reload file before every
programming option.

Options » Program settings - Programming - Warn
before file load, when data in some editor have
been changed causes that a warning appears if data
have been changed in any editors and automatic file
reloading option is set.

Options - Program settings - Programming -
Warn, when the loaded file has not changed causes
that a warning appears if the file loaded before
programming has not changed.

The following option can also be useful: Program
settings - Programming - After programming:
Close status window if there is no error.

There are special cases when developers do not have the
device's voltage supply pin available in an application
powered by an external source. In order to feed the
programmer's output circuits, power supply from the
programmer must be switched on in such a case and its
voltage set at the same value as used in the application.
Yet as some voltage still “sneaks” into the programmer
from the application through the programming pins, the
programmer “sees” that there is some voltage present
and refuses to activate its own output voltage. For such a
case the following option is available: Program settings
- Others - Allow internal and external supply
voltages collision.

WARNING: Activating this option in other situations
could damage the programmer!
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Programmer Settings

Each time a particular programmer is selected (FORTE or
PRESTO), the programmer settings window is displayed
allowing the user to set the voltage used and some other
important programming options.

If you are using an external power source for feeding the
application, the During programming option must not
be checked.

FORTE programmer settings

Supply from the programner: Actual voltage on YD D:
U None
45 50V 515

Iridle state
+ | Dluring programming

HvF

Fig.27: Programmer settings

The current voltage is continuously displayed in the top
right corner of this window.

Should an error i.e. overload occur, a warning appears at
this place.

The output voltage in the idle state if it is turn on can be
changed only if it is allowed under Options - Program
settings —» Others - Allow to change supply voltage
level when it is on (FORTE only).

If a voltage is present at the VDD pin, you can stop the
running microcontroller application by pressing the Reset
button and restart it by pressing the same button again.

Fuses and Working with Them

Characteristics of the device (fuse) to be programmed
can be set in the Configuration window. Changes in
fuses can be saved by choosing File - Save or File -
Save project....

If the given .hex file of device includes definitions of its
fuses, fuses are saved in it.

Fuses are saved together with a project in the case of
Atmel microcontrollers and memory chips. If you are
working with these, right-click the Configuration window
once you have set the fuses and use the Learn fuses
option.

If the Options - Program settings - Programming -
Reload file before every programming option is
active, the software reloads current file after the
Program button is pressed. If, however, fuses are not
saved in current file and no project is created from which
fuses could be used, the configuration memory initializes
into the default state before each programming
procedure. This can be avoided by deactivating the
Program settings - Files - Erase configuration
memory before file reading option.

Many devices have specific requirements for fuse
settings. Further information on how to correctly set their
fuses can be found in the particular device data sheet.

4.3.5 Programming

Select the file that you want to program by choosing File
- Open....

Once the file opens, you can see the current code/main
memory, data memory and configuration memory (fuses).
If you cannot see these windows, activate them under
the View menu.

The memory being programmed can be manually
modified at any time by simply marking the required
location and rewriting its value from the keyboard. If you
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want to save such a modification, choose File - Save,
File - Save as... or File - Export data memory to
file....

Important warning

It is recommended to check the programmer
settings and fuse settings before starting the
actual programming as an error in these

parameters could damage the device or even
the programmer.

The programming process is triggered by choosing
Device - Program or by clicking the Program button.

In some devices, the system checks the Device ID (device
electronic signature) and the code/data protection bits
before launching the programming process. If the ID does
not match the selected device type, a warning message is
displayed.

Displaying of this warning message is frequently caused
by a fault in the interconnection of the device and the
programmer.

If things are in order, the programmer performs the
following operations: erases the device, checks the
erasure, programs the device and checks the
programmed device.

If only a particular memory of a microcontroller needs to
be programmed, it can be done by choosing the
corresponding item in the Device - Program menu or
by clicking the pull-down arrow next to the Program
button on the button bar. Depending on the device type,
the following options may be available: program code/
main memory, program data (EEPROM) memory, program
configuration memory or program all.

Differential Programming

The Device - Program menu offers a possibility of
differential programming, provided the device to be
programmed supports it. If selected, the existing memory
content is read first and only cells that differ are then

4.4

programmed.

Differential programming is useful for development during
which content of the programming data changes very
often, but the changes are tiny. As only changed cells are
overwritten, the differential programming is advisable for
devices with a low number of writing cycles. It can also be
faster than the conventional re-writing of the whole
memory content.

Further Features

The following section focuses on selected additional
functions of UP available for device programming.

4.4.1 Setting the GO
Button

ASIX programmers feature a GO button, which allows the
user to trigger the programming process without a
computer mouse or keyboard.

The function of the GO button can be set under the
Options - Key shortcuts menu in the GO button field
to suit user's needs.

The UP software must be running if the user wants to use
the GO button, but may be minimized on the screen.

Additional settings associated with the GO button can be
found in Settings for Programming During Development.

4.4.2 Mass Production

The mass production function is available under the
Device - Program - Mass production menu. It can
also be called up by clicking the arrow next to the
Program button on the toolbar.
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£ Mass Production X

OK: 29/ Error: 18

Counter Reset

Don't prograrm data mermony

Frogram after ext. YDD appears

1 -

Open this farm after start

That's Enough

Fig.28: Mass production

The actual programming can be triggered by clicking the
Program button in the Mass production dialog
window.

The function of this button is identical to the Program all
or Program all except data memory options
depending on the state of the Don't program data
EEPROM checkbox in the Mass production window.

This dialog window also displays a counter of devices
programmed. Depending on the program settings, the
counter can also be displayed in the status bar. For
further information on settings see Production
Programming Settings.

The counter displays the number of programmed devices
in both the mass production mode and the standard
mode.

Pressing the Counter reset button zeroes all the mass
production counters. This operation cannot be undone.

The programming can be launched by connecting
external power supply (VDD).

When the "Open this form after start" setting is enabled,
the form opens after program start or after project file
open, if it is used.

4.4.3 Serial Numbers

The Serial Numbers function programs the serial number
or another sequence of characters in the selected
memory location.

Serial numbers

Actual SIN: 0001

[ wirite ] | Mext || Settings... |

Fig.29: Serial numbers

Once the serial numbers are activated and their type set
up under Options - Program settings - Serial
numbers, a window with the current serial number opens
offering the possibility to manually write a serial number
in the memory HEX editor, to specify where it should be
written and if the system should proceed to the next
sequential number.

Serial numbers can be:

* Computed

The computed serial numbers must always be written in
the same selected position in the device such as the
code/main memory, data memory or an ID position, for
example. The serial number is always expected to be a
number in decimal or hexadecimal format and may be
coded as a 4-bit combination (one to four characters per
word) or as an ASCIl character (one or two ASCI
characters per word). If the code/main memory is used for
Microchip microcontrollers, you can choose RETLW
instructions. Then RETLW instructions are written in the
given address of the code/main memory together with a
parameter corresponding with the serial number.

 Taken from File

A single serial number can be distributed in more than
one device memories (the serial number itself directly to
the program, the equipment address to the data memory,
and the serial number again to ID positions in order to be
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able to read it from a locked device, for example).

Note: A word is understood as one memory position.

Program settings

=x=)

| Frogramming | Fanels | Files | Caolarg | Editl:nrs| Serial numbers I Checksur 4| *

Serial numbers

() Are not
() Fror file

(@) Compute

[Logtafile

Serial number interval:

1 wd
=

Prepare S/M before programming

Find successor after prograrmming

Prepare S¢M after prograrmming

Browse...

Serial number length (characters)
(ad
i ®
Mumber base:
@) Decimal
() Hexadecimal

[[]code as ASCH

Initial serial numkber,

Destination

@) Program

() Data memaory
(1D positions

Hexadecimal address of first
ek

ooono

nom Fill with RETLW instruction
Next /N (}tharaders per-\v\_rord
(C) The same b % &5
(@) One interval higher g [
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() Generated LSFR S_equence:
(@ HiLa hilo
(" hilo HiLo
) () LaHi Iohi
Ser.lal number.length {the number of chare - ' lohi LaHi
Estimated period: 10000 :
Ok, l \ Cancel ‘ l Apply J l Load defaults

Fig.30: Serial number settings

A file for logging the programmed serial numbers can be
selected under Options - Program settings - Serial
numbers.

The numbers themselves are logged in case of calculated
serial numbers while their labels are logged in case of
serial numbers taken from a file - see Format of Files with
Serial Numbers.

Format of Files with Serial
Numbers

Files containing definitions of serial numbers are text files
that can easily be created in third-party programs. *.SN or
* TXT are recommended file extensions.

A serial number record has the following form:

[comment] label: data record, data record, ...,
data record;

Semicolons are obligatory at the end of records.

« Comment is any string containing no colon ":".
Comments are optional. If a colon cannot be found in
the whole serial number record, the record is ignored
(understood as a comment).

This is just a comment;,

* White character is a space, tabulator or end of line
(CR+LF).

* Label is a string identifying the serial number. This
string is compulsory. The label must not contain white
characters, colons or semicolons.

Data Record

A data record consists of an address and data items in a
chain following this address.

Each item can be written in hexadecimal form (e.g. 2100)
or a numeral base in which the number is written in can
be explicitly defined.
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For example, b'10101010' means the same as h'AA’,
d'170' or just AA. 'A' means d'65' (ASCII character itself).

Example record for PIC16F628A:

2100 05 55 54 means to save data 05h, 55h, 54h in
addresses 00 to 02 of a data memory.

The code/main memory which stores the serial humber
can also be specified by the word “CODE.” or “PROG.” or
just “P.”.

The data memory should be specified by the word
“DATA."” or “EE.” or just “E.”.

“ID” or just “1” is used for the memory of ID positions.

These words are always followed by an address inside the
specified memory.

Example:

EE.0O0 05 55 54 means to save data 05h, 55h, 54h in
addresses 00 to 02 of a data memory.

Notes

* * There is no specifier for the configuration memory, it
would make no sense.

dsPIC - addresses of 24-bit words are to be written in for
all addresses (i.e. an internal dsPIC address of 24h is 12h
here). For a data (EEPROM) memory addresses of 16-bit
words are to be written in, i.e. as they go one by one
through the microcontroller.

* Autonomous memory chips (I12C, SPI) have only the code
memory. If a non-existent memory is specified, an error
is reported.

Example of File with Serial Numbers

Comment at the beginning;,
snl: 0000 34 45 56 67,

2100 01 02 03 04, serial number 1
sn2: 0000 45 56 67 78, 2100 02 02 03 04,
sn3: 0000 56 67 78 89, 2100 03 02 03 04,

note

sn4: 0000 67 78 89 9A, 2100 04 02 03 04,
sn5: 0000 78 89 9A AB, 2100 05 02 03 04,
sné6: 0000 78 89 9A AB, 2100 06 02 03 04,
sn7: 0000 78 89 9A AB, 2100 07 02 03 04,
sn8: code. 0001 3F00 3F01 3F02 3F03,
data.0002 'x' '4' '2';
sn9: prog.0001 3F00 3F01 3F02 3F03,
e.0002 'x' '4' '3';

4.4.4 Calibration Memory
Support

Some devices contain a calibration memory containing
factory-preset device calibration. The loss of its content
can cause a fault in the device functionality. For this
reason we have tools allowing users to work with the
calibration memory.

Working with Calibration
Memory When Erasing a Device
in UV Eraser

Calibration data should be saved prior to erasing a
device. To do so, choose File - Save calibration
data...

ou can retrieve it back by choosing File - Read
calibration data...

The program contains a function for verifying whether a
device has been erased correctly: Device - Blank
check. When this command is used, the program displays
data from the calibration memory.
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4.5

Working With Calibration
Memory in Devices With Flash
Memory

When these devices are erased, the content of their
calibration memory is preserved.

If you really need to erase the calibration memory for
some reason, you can do so by choosing Device - Erase
- Erase all (including calibration).

Advice

New Flash devices with a calibration memory (such as
PIC12F629) contain so called 'bandgap bits', which form
part of the device calibration. These bits can be found in
the configuration word and are erased too if the
command Device - Erase - Erase all(including
calibration) is executed!

Program Controls
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Fig.31: Controls of UP software
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2)Menu
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4.5.1 Toolbar

A toolbar is a panel with quick selection buttons located
under the program menu (see Program Controls).

If you want to remove the toolbar, simply uncheck the
Display icons and descriptions on the toolbar button
options in the Settings menu as described in Program
settings.

4.5.2 Status Bar

The status bar is a panel in the bottom part of the window
(see Program Controls). It presents information on the
programmer, the device, changes to the file since the last
saving, etc.

Individual parts of the status bar react to double-clicking
and to the context menu that opens after right-clicking.

If you want to hide or re-display the status bar, choose
Program settings - Panels - Display the status bar
in the lower part of the window.

4.5.3 Menus

The following texts describe in detail individual items in
the UP software menus.

Menu commands can be triggered with mouse by clicking
on a particular menu item or from the keyboard by
pressing the key together with the shortcut, i.e. the
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underlined letter in the menu.

The menu bar consists of the following menus
(categories):

* File Menu

* Edit Menu

* View Menu

* Device Menu
* Options Menu

* Help Menu

File Menu

File > New
Keyboard shortcut: Ctrl+N

The program creates a new empty file. If the currently
open file has not been saved, the program prompts the
user to save it.

File - Open...

Keyboard shortcut: Ctrl+0

The program opens the Windows standard dialog listing
the files saved on the disc. The supported file formats are
described in Appendix C: Intel-HEX File Format. Files with
extensions .hex or .a43 are loaded as Intel-HEX, others as
binary. There are also filters available making it possible
to open all files as .hex or as .bin.

File - Open next file...

The program imports another .hex or .bin file with an
optional offset. This function is useful if the user needs to
load another file into device's memory. Files with
extensions .hex or .a43 are loaded as Intel-HEX, others as
.bin.

For example, this command provides for merging of
several .hex files (e.qg. bootloader + program).

File » Reload actual file
Keyboard shortcut: Ctrl+R

The program re-opens (i.e. re-reads from the disc) the
currently open file. This command is useful if you know
that the file on the disc has changed and you want to load
these changes into the program.

If you are using Program settings - Files - Do
automatic check for newer versions of actual file,
the program automatically notifies the user of a change in
the currently open file and offers its reloading.

File - Save
Keyboard shortcut: Ctrl+S
The program saves the file on a disc. If you want save

your file under a different name than the current one, use
the Save As... command instead.

The program can skip unused locations of the memory.
See Program settings for details.

File » Save as...
The program saves the open file on a disc under a new
name using the Windows standard dialog.

The program can skip unused locations of the memory
while saving or not to save certain selected locations.
See Program settings for details.

File = Import data memory from
file...

Using the Windows standard dialog, the program reads
and imports the content of a data (EEPROM) memory
saved in a different file. This allows the user to load a
data memory if this has not been saved in the same file
as the code/main memory (this concerns ATmega8
microcontrollers, for example).

Important warning

Such a file, regardless of its content, is read from the zero
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address as if it contained only the data (EEPROM)
memory. This means that a file generated normally by a
compiler cannot be correctly read using this command.

File - Open file with data memory
automatically

With this option selected, the program automatically
loads the file for the data memory alongside with loading
the file for the code/main memory. This option is active
only if a separate file is loaded for the data memory.

File > New project
Keyboard shortcut: Shift+Ctrl+N

This command creates a new project.

It is especially advisable to use project files if you
frequently switch between programming different device
types or if you are using several different programmers. A
project file contains all the corresponding settings and
provides for loading of all of them in one step.

File - Open project...
Keyboard shortcut: Shift+Ctrl+0

Using the Windows standard dialog, the program opens
an already existing project file saved on a disc. If an
additional file had been opened together with the project,
such a file opens as well.

File - Save project...
Keyboard shortcut: Shift+Ctrl+S

Using the Windows standard dialog, the program saves
the current project under a new name. Saving of the
project under the same name is done automatically as
well as saving the program settings, for example.

File - Close project
Keyboard shortcut: Shift+Ctrl+W

The program terminates the work with the currently open

project, saves the project file on the disc and returns to
the state in which it was before the new project was
opened.

File » Recent projects

This function remembers the last 10 opened projects.
Clicking the name of one of them opens the project.

File > Read calibration data...

Using the Windows standard dialog, the program opens a
file with the calibration data and loads the data in the
memory.

File -» Save calibration data...

Using the Windows standard dialog, the program creates
a file with the device's calibration data previously read
from the device connected to the programmer. This
calibration data can be reloaded using Read calibration
data if the device gets erased in the meantime.

For further information on the program's support of work
with the calibration memory see Calibration Memory
Support.

File - Export to bin...

This command saves binary data from the code/main
memory, from the data memory or from ID positions in a
selected file.

16 or 8 bits word width can be selected for the data to be
saved.
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File » Exit

Standard Windows keyboard shortcut: Alt+F4
Keyboard shortcut: Alt+X

Warning

If closing of the program is forced by the Tum
Computer Off command and the program
does not receive the user's confirmation, the

system closes it forcibly after some time
without saving the open file or settings.

If the program is currently working with the
hardware, it refuses all system's requests to
turn off and can be seen as “not responding”
by the system.

This command closes the program. If the open file has
changed, the program prompts the user to save the
changes.

Edit Menu
Edit = Fill with value...

The program fills a memory location with a specified
value. This command is used especially for erasing (filling
with ones) or zeroing (filling with zeros) a particular
location. Yet it can be filled with any value or with random
data.

When the Fill with value... command is called, the
program presets the selected memory according to the
active window. If a memory location was highlighted
before calling this command, the program presets the
marked location for filling in.

A memory location can be selected by holding the Shift
key and clicking by mouse or moving by means of the
cursor keys (arrows). For further information on
highlighting a location see HEX Editor Windows.

Edit » Text insert...

This command saves a text in ASCIl or in hexadecimal
format into a selected memory location. Ends of lines can
be coded as NULL, CR, LF or CR+LF characters.

Individual bytes can be inserted as well as saved in
RETLW instructions (this applies only to the code/main
memory working with Microchip microcontrollers).
Note: Microchip PIC RETLW instruction means return with
a constant value in the work register - this instruction is
frequently used for creating tables.

If the Text insert... command is called, the program
presets the selected memory and the starting cell
according to the current window and the selected cell.

Edit = Fill selected location with
RETLW

This command fills the selected Microchip
microcontroller's memory location with RETLW.

The command can be called only from an open HEX
editor. It is also available through the context menu (right
mouse click) in the editor.

A memory location can be selected by holding the Shift
key and clicking by mouse or moving by means of the
cursor keys (arrows). For further information on
highlighting a location see HEX Editor Windows.

View Menu
View =» Code/main memory

This command opens or closes the code/main memory
HEX editor window. For more on HEX editors see HEX
Editor Windows.

View = Data memory

This command opens or closes the data memory HEX
editor window. For more on HEX editors see HEX Editor
Windows.
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View = Boot memory

This command opens or closes the boot memory HEX
editor window. For more on HEX editors see HEX Editor
Windows.

View = Configuration memory

This command opens or closes the configuration memory
HEX editor window. For more on HEX editors see HEX
Editor Windows.

View = Console

This command opens or closes the console, where the UP
can write details about programming.

View = Display code/main memory
Keyboard shortcut: Alt+F10

This command displays the code/main memory HEX
editor. If it is already displayed, it moves it to the front

(the editor gets focus). For more on HEX editors see HEX
Editor Windows.

View - Display data memory

Keyboard shortcut: Alt+F11

This command displays the data memory HEX editor. If it
is already displayed, it moves it to the front (the editor

gets focus). For more on HEX editors see HEX Editor
Windows.

View = Display configuration
memory
Keyboard shortcut: Alt+F12

This command displays the configuration memory HEX
editor. If it is already displayed, it moves it to the front
(the editor gets focus). For more on HEX editors see HEX
Editor Windows.

Device Menu

Device = Program
Keyboard shortcut: Shift+F5

This command opens a sub-menu with programming
options. Some items may be inaccessible for certain
device types.

» Program all
Keyboard shortcut: F5

This command erases the device, checks the erasure,
programs it and verifies the programming result in the
whole device. The Device ID check and the Code/Data
Protection check are performed prior to this operation.
The behavior of this command is influenced by the
program settings - see Program settings.

» Program all except data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts.

This command works the same as Program all with the
exception that it does NOT erase, program or verify the
data memory.

Devices without a data memory do not have this
command available and their programming is done using
the Program all command.

This command cannot be used in some cases that use
Code or Data Protection. For these, the program offers
the command Erase whole device and program also
data memory (with data currently in the editor).

» Program code/main memory

A keyboard shortcut can be assigned in Options - Key
shortcuts.

This command erases the code/main memory, checks the
erasure, programs and checks the programming result.
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» Program data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command erases the data memory, checks the
erasure, programs and checks the programming result.

» Program configuration memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command programs the configuration memory and
ID positions (if device contains them) and checks the
programming result

» Program differentially
Keyboard shortcut: Ctrl+F5

This command programs the device applying the
differential method. This means that it reads the device
and programs only those cells the content of which differs
from the editor.

This command is available only for those devices that
support such treatment (not all devices do).

If a device has the Code/Data Protection active,
differential programming makes no sense. The program
performs complete programming instead, including
device erasure.

» Differential program data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command programs the data memory applying the
differential method. Its function is identical with
differential programming of the code/main memory.

This command is available only for those devices that
support such treatment (not all devices do).

If a device has the Code/Data Protection active,
differential programming makes no sense. The program

performs complete programming instead, including
device erasure.

Differential programming of a data memory should be
used for AVR microcontrollers if the user needs to
reprogram the data memory only without previously
erasing the device.

» Mass Production

A keyboard shortcut can be assigned in Options » Key
shortcuts

This command opens a window for easy programming of
several identical devices with the same or very similar
program(s) (except their serial numbers and the like). For
further information see Mass Production.

Device - Read
Keyboard shortcut: Shift+F6

This command opens a sub-menu with device reading
options. Some of them may be not available for certain
device types.

» Read all
Keyboard shortcut: F6
This command reads the content of the whole device.

» Read all except data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command reads the content of the whole device
except the data memory.

» Read code/main memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command reads the content of the code/main
memory.
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» Read data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command reads the data (EEPROM) memory.

» Read configuration memory

A keyboard shortcut can be assigned in Options » Key
shortcuts

This command reads the configuration memory and ID
positions (if device contains them).

Device = Verify
Keyboard shortcut: Shift+F7

This command opens a sub-menu with device memory
content verification options. Some of them may be not
available for certain device types

» Verify all
Keyboard shortcut: F7

This command compares the content of all device
memories with the current content of HEX editors.

» Verify all except data memory

A keyboard shortcut can be assigned in Options » Key
shortcuts

This command compares the content of all device
memories except its data memory with the current
content of HEX editors.

» Verify code/main memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command compares the content of the code/main
memory with the current content of code/main memory's
HEX editor.

» Verify data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command compares the content of the data memory
with the current content of data memory's HEX editor.

» Verify configuration memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command compares the content of device's
configuration memory and ID positions (if device contains
them) with settings in the Configuration window.

Device = Erase
Keyboard shortcut: Shift+F8

This command opens a sub-menu with device memory
erasing options.

Erasure verification (blank check) is automatically
performed after each erasing. This verification can be
skipped by choosing Options - Program settings -
Programming - Do not perform blank check after
erasing. This can save time with some devices.

» Erase all

Keyboard shortcut: F8
This command erases the whole device.

» Erase code/main memory

A keyboard shortcut can be assigned in Options » Key
shortcuts

This command erases the code/main memory. It cannot
be used if Code/Data Protection is active.
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» Erase data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command erases the data memory and verifies it. It
cannot be used if Code/Data Protection is active.

Device - Blank check
Keyboard shortcut: Shift+F9

This command opens a sub-menu with device erasure
verification options. Some of them may be not available
for certain device types.
» Blank check all

Keyboard shortcut: F9

This command verifies whether the device is correctly
and completely erased.

» Blank check all except data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command verifies whether the device except the
data memory has been correctly erased.

» Blank check of code/main memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command verifies whether the code/main memory is
correctly erased.

» Blank check of data memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command verifies whether the data memory is
correctly erased.

» Blank check of configuration memory

A keyboard shortcut can be assigned in Options - Key
shortcuts

This command verifies whether the configuration memory
and ID positions (if device contains them) are correctly
erased.

Device = Select device
Keyboard shortcut: F4

This dialog allows you to select a device type to be
programmed. Some memory types need to have their
data organization selected after the device type
selection.

Only devices supported by the currently selected
programmer are displayed in the dialog window. If you
want to select a device not supported by the current
programmer, select a different programmer type first.

For further information on selecting a device see Device
Type Selection.
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Options Menu

Keyboard shortcut: Shift+F10

The Options menu holds all the possible settings of the
UP program. There is a great number of setting
parameters. If you are not sure that all settings are
correct, you may use the Load defaults button, which
returns all the settings to the initial (factory) state.

Advice

Program settings — Load defaults button renews the state of
all settings on all tabs, i.e. even the color settings, for example.

Options = Program settings -
Programming
Keyboard shortcut: Shift+F10

This tab provides for setting all the general programming
parameters.

Settings concerning the programmer and the
communication port are described in Programmer
Selection.

A special Device = Select device window is available for
setting the device type.

» Reload file before every programming

The program reads the current file with programming
data from the disc before each and every request to
program a device if this option is checked.

If the use of serial numbers is also activated requesting
reading the current file prior to programming, then the
file is read first and only then is the current serial number
written.

» Warn before file load, when data in

some editor have been changed

When before load of the file before programming it is
found that data in some editor have been changed, the
program shows a warning.

» Warn, when the loaded file has not
changed

Program shows a warning, when the content of the
loaded file has not changed from the previous
programming.

» Ask before erasing

With this option checked, the program asks for user
confirmation before erasing a device.

» Ask before programming of OTP / Flash
/ Code/Data Protection / differential

A set of options determining which user confirmation
dialogs will or will not be displayed by the program.

The program asks just once except the Code/Data
Protection programming. If the program needs to ask
the wuser for additional information before actual
programming (such as Device has Code or Data
Protection. Do you want to erase it entirely?), it
does not ask for further programming confirmation after
answering the first dialog.

» Display fuse warning messages

The user can choose if warning messages should be
displayed for some fuses. It is recommended to leave this
option on.

» Except for programming: Close status
window

This option closes the status window if no error occurs
during erasing, blank check, programming verification
and reading.
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» After programming: Close status
window

This option closes the status window if no error occurs
during programming and the subsequent verification.

» Beep after successful finishing

With this option active, the program calls up the standard
Windows system beep if the operation (such as erasing,
programming, etc.) went smoothly.

» Beep after unsuccessful finishing

With this option active, the program calls up the standard
Windows system beep if an error or warning occurs during
the operation (such as erasing, programming, etc.).

» Turn off all sound for UP

With this option on, the program does not produce any
sounds.

» Delay for VDD switching on/off when
supplied from programmer

This option is important for programming PCB-placed
devices via an ICSP cable. It determines the length of the
delay after voltage is connected to or disconnected from
a device.

Both PRESTO and FORTE feature an overcurrent
protection. This means that a test for excessive current of
approximately 100 mA in power supply voltage is
performed after connecting power to the device and
expiration of the delay time set in Switch on.

Similarly the delay time set in Discharge specifies how
late after switching the power supply off a check should
be performed if no voltage is present any longer at the
pin.

If a blocking capacitor is connected to the device's power
supply pins (recommended), the voltage at the pin
changes more slowly. This could cause problems during
programming, but they can be eliminated by prolonging
the charging and discharging time.

Too long a time increases the risk of damaging the device
if connected incorrectly while too short a time could
cause programmer's circuits to still detect excessive
current flowing to the application's capacitors. A formula
for an approximate determination of the necessary time
can be found in Appendix B: Use of ICSP.

» Do not perform blank check before cfg
word programming

Most rewritable devices can overwrite the configuration
word without erasing the whole device content. Skipping
the blank check of the configuration word utilizes this
possibility, i.e. the program ignores the not erased word.

This option does not apply to the whole-device
programming in which the device is erased completely. It
concerns only the configuration word and its overwriting.

» Do not perform blank check after

erasing

This option speeds up the programming process and is
useful especially for debugging. The danger is that an
incorrectly erased device is subsequently incorrectly
programmed and the fault only gets detected later. On
the other hand, a device is erased incorrectly only once in
several hundred attempts.

» Do not erase device before
programming
The device is not erased before programming.

» Do not erase data memory before its
programming

This option only concerns programming of Atmel AVR
devices e.g. ATmega8. Data memory of this family
devices does not require to be erased before
programming. If this option is not activated, whole device
will be erased before programming.
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» Do not verify unprogrammed words at

the end of the memory

If there is a location at the end of the code/main memory
containing only default values, it is not verified.

This option speeds up the verification of the programmed
memory as the content of the “empty” memory at its end
usually does not matter.

» Do not verify

This option completely switches off the verification of a
programmed device. Such off-switching can radically
speed up the programming process during development.

This option must not be activated for production as
correctness of the programmed content would not be
guaranteed.

» Verify with two supply voltages

This option is available only for FORTE and only for the
internal power supply from the programmer. It allows you
to perform the verification at two different power supply
voltages defined by the user.

Some device manufacturers recommend to verify the
content after production programming at two different
voltages corresponding with the approved range of the
device's power supply voltages.

Options = Program settings —»
Panels
Keyboard shortcut: Shift+F10

This part of the Options menu allows you to alter the
application's appearance. The user can set where and
how some control components are to be displayed.

» Display selected device on toolbar

In addition to the status bar, the selected device is also
displayed in the toolbar.

» Display selected programmer on
toolbar

In addition to the status bar, the selected programmer is
also displayed in the toolbar.

» Display the status bar in the lower part
of the window

This option determines whether the status bar is to be
displayed or not.

» Display icons on toolbar buttons
Icons of individual tools are displayed in the toolbar.

» Display descriptions on toolbar buttons

Tool names are displayed next to individual tools in the
toolbar.

If the Descriptions on toolbar buttons to the right
option is used, the total toolbar height is reduced to a
half.

» Show mass production counter in

status bar

This option displays the mass production counter in the
status bar. The counter shows the number of devices
programmed and the number of devices programmed
successfully.

If you use the Count all actions option, the counter
includes all actions performed with the device (such as
reading, erasing, data memory programming, etc.).

Show values description displays explanatory notes to
individual counter items for easier understanding.

If you want to exclude operations that triggered a
warning from the correct operations, use the If action
ends with warning assume as erroneous option.

The choice Reset counters on project open causes,
that the counters are reset on any project file load,
including automatic project load during program start.
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Counter style allows you to choose whether the counter
should display the good/bad or good/total figures.

The Counter reset, button can be used for zeroing the
counters while their initial values can be set in the Preset
counter values fields.

Options = Program settings = Files
Keyboard shortcut: Shift+F10

This tab holds all the settings for reading data from and
saving data to files.

» File save style

The File save style panel offers the possibility not to
always save all areas of all editors in the file, but rather
only some. UP then asks questions based on the saving
style settings before saving different project editors.

» Automatically check for newer versions

of actual file

This option helps especially in debugging a program. The
program re-loads the file if it detects a change in the file
modification date.

» Check device type when loading .hex
file

If the device type has been saved in the corresponding
Intel-HEX file and it does not agree with the currently

selected device type, the program points out this
discrepancy.

» Save device type into .hex file

The program adds one more line below the end of file
command specifying the type of device for which the file
is being saved.

Such a modified file does not comply with the Intel-HEX
format, but most programs working with the Intel-HEX
format ignore this line.

For further information about the Intel-HEX format see

Appendix C: Intel-HEX File Format.

» Warn when loaded HEX does not

contain CFG memory data

If the file does not contain configuration memory data
and the data are expected for the chosen device, a
warning message is displayed.

» Warn when loaded HEX is not aligned

to word size.

If the file is not aligned to the word size of the memory of
the device, a warning message is displayed.

» Binary file loading and saving style

This panel provides for the setting of how .bin files are to
be loaded and saved if a device with more than one byte
per word is selected.

Available options are: the program always asks before
loading or saving a .bin file (Ask if to load/save .bin as
Big or Little Endian), or without asking, the program
always loads files as Little Endian (Never ask, load/save
as Little Endian) or as Big Endian (Never ask, load/
save as Big Endian).

» Save unused locations to .hex file

If not all positions are saved, the final file is smaller, but it
can cause difficulties as a cell is considered an “empty
position” if it contains only ones (e.i. FFFh, 3FFFh, etc.).
Yet this could be a meaningful instruction (3FFFh is
Microchip PIC addlw -1 instruction, for example).

As UP always saves files by larger blocks, (by eight or
sixteen bytes), the danger of losing an instruction by such
saving is rather small in reality.

If you use memory initialization prior to loading a .hex file
(which is recommended), even a program loaded from a
reduced .hex file will be correctly programmed as the
missing instructions are created “automatically”.
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» Clear code/main / data memory / ID
positions before file reading

This location is filled with ones and only then a file is
loaded. This way all positions that are not saved in the
.hex file get erased.

This option is also important if no “empty” locations are
saved in the .hex file (see » Save unused locations to .hex
file).

» Erase configuration memory before file
reading

With this option activated, the configuration memory is
initialized before a file for code/main memory is loaded.

If no fuses are saved in the file, it is recommended to
deactivate this option. At the beginning of the work, the
user can set the content of the configuration memory and
then the fuses do not have to be set again if the file is
repeatedly loaded.

» Read data memory not from the file but
from the device

If you want to make sure that the content of the data
memory does not get overwritten, use the » Program all
except data memory option. If, however the » Program all
option is selected by accident (by unintended pressing of
the GO button, for example), the content of the data
memory would be erased.

For such cases, this option of Read data memory not
from the file but from the device is available. The
program fills in the given location with the memory
content of the device connected to the programmer.

Advice

This option could cause unexpected actions during work
with the programmer such as switching the application on
or starting the UP program.

» Read ID positions not from the file but
from the device

If you want to preserve the content of the ID positions,
use the Read ID positions not from the file but from
the device option. The program fills in the given location
with the memory content of the device connected to the
programmer before starting the programming itself.

Advice

This option could cause unexpected actions during work
with the programmer such as switching the application on
or starting the UP program.

» Project saving style

This panel allows you to set how projects should be saved
when exiting UP. Available options are: save
automatically, ask before saving or keep the original file
(i.e. do not save).

Options = Program settings —»
Colors
Keyboard shortcut: Shift+F10

This is where you can change and save colors of HEX
editors so that they suit your needs and your aesthetic
preferences.

A front color, a background color and a font can be
selected for all the listed text segments.

Options = Program settings -
Editors

Keyboard shortcut: Shift+F10

» Code/main memory editor: show words
as bytes

Individual words can be displayed by bytes in case of
devices with 16-bit-long words.
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» Code/main memory editor 8 words
wide

This option narrows the editor from the original sixteen
cells down to eight. The option is suitable especially for

small monitors. It can change automatically when a
different device type is selected.

The same option can be set for others memories:

» Data memory editor 8 words wide
» Boot memory editor 8 words wide

» Show only the lowest byte of word in
ASCII

When this option is activated, the program shows the
ASCII translation of only the lowest byte of word, which
can be useful especially for PIC MCUs.

» Mask ID positions while reading from

device, from file, etc.

Some manufacturers' specifications recommend saving
only masked data (with only four bits usable) in ID
positions. With this option activated, the program always
applies this bit mask when reading ID positions from
different sources.

» Mask ID positions during direct user
input

With this option activated, the program applies the bit
mask to each user-modification of ID positions. For further

information see » Mask ID positions while reading from
device, from file, etc..

» Configuration memory editor: show cfg

word instead of fuses
This option is recommended for advanced users only. It is
not saved in the UP configuration file for safety reasons.

Direct editing of fuses is understood as direct writing of a
configuration word value in the hexadecimal form.

When a “non-translatable” configuration word is entered,
the program leaves the unrecognized items unchanged
unless the user changes them him/herself. This typically
concerns CP fuses having several bits but only two
values.

Options = Program settings = Serial

numbers
Keyboard shortcut: Shift+F10

For further information on working with serial numbers
see Serial Numbers.

» Serial numbers

This tab allows you to choose whether serial numbers are
to be used and if so then whether they should be read
from a file or computed and whether they should be
automatically written to the corresponding location.

» Prepare S/N before programming

This option prepares a serial number in the selected
memory location before the actual device programming.

» Find successor after programming

Once one programming procedure is successfully
completed, the system proceeds to the following serial
number. If this option is not activated, it is still possible to
proceed to the following number manually by clicking the
Next button on the Serial numbers tab - see Serial
Numbers.

» Prepare S/N after programming

This option causes that a serial number is prepared in the
selected memory location after the device programming.

» Serial number interval

This defines by what value the following serial number
will be larger or smaller.
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» Log to file

By activating this option and by selecting a log file in the
field, information about correctly and incorrectly
programmed devices as well as the programming time is
saved in the selected file.

For further information see Serial Numbers.

» Serial number length (the number of

characters)

This field determines how many characters the serial
number can hold. For example, 4 characters provide for
the serial numbers 0001 to 9999 in base 10 (i.e. in
decimal form).

» Number base

This option defines the base of the serial number
characters. Base 10 and base 16 are available (i.e. the
decimal and hexadecimal forms).

» Code as ASCII

With this option activated, serial numbers are legible as
ASCII characters.

» Initial serial number

This field defines the initial value from which serial
numbers are to be computed.

» Next S/N

This field defines how the following serial number is to be
generated.

If The same is selected, the serial nhumber does not
change. If One interval higher is selected, the following
number will be larger by the value of » Serial number
interval while if One interval lower is selected, it will
reduce by that value.

The Generated LSFR option generates the numbers in a
pseudo-random sequence. This means that the sequence
will always be the same if the same Initial serial

number and the same Serial numbers step is used.

» Destination

This panel determines the memory location in which the
serial numbers are to be stored. Code/main memory,
data memory and ID positions are available as
options.

» Hexadecimal address of first word

This address defines where the first word of the serial
number is to start in the selected memory type.

» Fill with RETLW instruction

Individual words of the serial number can be filled with
RETLW instruction in Microchip microcontrollers. This
option is available only if the serial number is located in
the code/main memory.

» Characters per word

This panel determines how many serial number
characters form one word. Options of 1 to 4 characters
per word are available.

» Sequence

This panel sets how individual serial number characters
and words are to be ordered.

For example, if you have a base 10 serial number
consisting of four characters organized as 2 characters
per word and you are working let's say with 1234 as the
serial number, it will be saved in the following ways:

HiLo hilo: 12 34
hilo HiLo: 34 12
LoHi lohi: 21 43
lohi LoHi: 43 21
Options = Program settings -

Checksum
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» Show checksum in status bar

After enabling of this setting the checksum of the code
memory will be shown on the status bar.

Note: Doubleclick on the checksum value in the status bar
will cause the value recalculation.

» Checksum algorithm

Using this choice the checksum calculation algorithm can
be chosen.

Options = Program settings —»
Others

Keyboard shortcut: Shift+F10

» Update check settings

Here you can set if the program should ask for your
permission to connect to the Internet and check for
updates upon each start or not.

For further information see Updating UP.

» Allow internal and external supply
voltages collision

Warning
A collision of power supply voltages can
damage the programmer or the application!

If you approve the collision of supply voltages, it allows
the programmer to connect its internal voltage to pin
VDD at times when it can already see a voltage present
there. This could damage both the programmer and/or
the application being programmed.

This option has been included for very specific cases. One
of them can be a request to program an application,
which does not have any VDD pin. Then the application
must be powered from its own source but the
programmer's output buffers must be powered from the
USB. Yet as the voltage at the application's data signals

“sneaks” through the protective diodes into the output
section of the programmer, the programmer can see a
certain small voltage present at VDD and refuses to
connect its own internal voltage to it.

» Do not show warning if internal 5 V is
switched on with 3.3 V device

Warning
High a voltage at the device can damage the
programmer or the application being

programmed.

This option can be used to suppress the warning if a
higher voltage is switched on at the VDD output than the
value allowed for the particular device.

If there is a voltage convertor integrated in the
application between the device being programmed and
the programming interface, it might be useful to use this
option of programing at a higher voltage than what the
device has been designed for.

This option is available only for PRESTO.

» Allow to change supply voltage level

when it is on

In order to protect the application connected to FORTE
from damage, it is typically forbidden to change the
output voltage level if the voltage is currently connected
to the application. After activating this option, the output
voltage can be changed at any time within the range that
the device being programmed can cope with.

Options = Select programmer

Settings concerning the programmer and the
communication port are described in Programmer
Selection.

Options = Language selection...
Keyboard shortcut: Ctrl+L

A file with a different language localization can be
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selected using the Windows standard dialog. This means
that one program installation can easily switch between
different user-interface languages.

Options = Keyboard shortcuts...
Keyboard shortcut: Ctrl+K

Using this dialog window you can define or change
keyboard shortcuts for most commands the programmer
is capable of performing.

This window also provides for setting the required
behavior of the GO button.

Help Menu

Help = Help on program
Keyboard shortcut: F1

This command opens the help that you are are just
reading.

Help = List of supported devices

This command displays a list of devices -currently
supported by the latest version of UP.

Help = Check Internet for updates

The program connects to the Internet and checks if you
are using the latest version.

Help = ASIX website

This command opens www.asix.cz, the website of ASIX
s.r.o. where you can find the latest drivers and manuals
for ASIX products.

Help - About

Basic information on the program and a contact to
technical support.

4.5.4 Programmer Settings
Window

All important settings concerning the programmer and
the applications to be programmed are displayed in the
programmer settings window.

The window appearance changes in accordance with the
selected programmer and device.

FORTE Programmer Settings
Window

Power supply from the programmer

This trackbar allows the user to set the voltage level
supplied to the application by the programmer.

In idle state

If this option is checked, the programmer supplies power
to the application even when not programming.

During programming

If this option is checked, voltage from the programmer
will be used during programming.

Reset

This button allows you to switch levels on the device's
reset pin between the level required for reset and high
impedance.

Reset is active if voltage is present on the power supply
pin.

Settings Associated with PIC
Microcontrollers
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» Programming method

* HVP Traditional programming will be applied using a
voltage of 8 Vto 13 V at pin P.

* LVP Programming utilizing the microcontroller's LVP pin
will be applied; only logical values of 0 or 1 are present
at programmer's pin P.

» Use PE

Programming utilizing the Use PE option can be applied
to PIC24 and dsPIC33 devices. PE stands for Programming
Executive and it is a programming method frequently
proving to be faster.

Boot memory programming

This allows to select the boot memory region to be
programmed or checked.

Settings Associated with AVR and
8051 Microcontrollers

Oscillator frequency

An external oscillator or a functional internal oscillator
must be connected in the course of AVR microcontroller
programming. The frequency setting must match the
frequency at which the device's oscillator is really
running, after eventual dividers. The maximum speed of
communication with the microcontroller then depends on
the frequency of this oscillator.

Faster Programming with Slow Clock

If this option is active, once the device is erased, the
fuses are programmed at the maximum frequency of the
internal oscillator. This allows the programmer to
communicate with the device at a faster speed. At the
end of programming, the required value of the
communication memory including the clock speed is
programmed.

This option has its effect only if the whole device is
programmed.

Inverse Reset

With this option activated, the programmer generates an
inverse reset signal.

This option is appreciated if the application includes a
reset circuit that needs an inverse signal at the input
compared to the output signal sent to the microcontroller,
and if the programmer is connected via this reset circuit.

HVP

If this option is checked, the programmer uses the “high”
voltage at pin P for communication with the device.

This allows you to program a device with the external
RESET signal switched off.

Settings Associated with 12C
Memory Chips
|12C Bus Speed

Select the maximum possible speed of the I°C bus. The
programmer switches on the internal pull-up of 2.4 kQ
while working on the 12C bus.

I2C Memory Address

Select the address of the I12C memory on the bus.

PRESTO Programmer Settings
Window

In idle state

If this option is checked, the programmer supplies power
to the application even when not programming.

During programming

If this option is checked, voltage from the programmer
will be used during programming.
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Settings Associated with PIC
Microcontrollers

MCLR Pin Control

The logical value present at pin P1 (VPP) can be
controlled by the Run, Stop, Tristate and Reset buttons
in the idle state if a voltage is present.

The Reset button generates a resetting pulse.

Programming Method

* HVP Traditional programming is applied with 13 V
present at VPP.

* LVP Programming utilizing microcontroller's LVP pin is
applied, only logical values of 0 or 1 are present at
programmer's pin P.

Algorithm Programming

* Auto An algorithm is selected according to the voltage
currently present at VDD.

* Ucc=5 V The algorithm for fast 5 V programming is
used.

* Ucc=2.7 to 5.5 V The algorithm for slow programming
is used with the benefit of working at all power supply
voltages.

Use PE

Programming utilizing the Use PE option can be applied
to PIC24 and dsPIC33 devices. PE stands for Programming
Executive and it is a programming method frequently
proving to be faster

Boot memory programming

This allows to select the boot memory region to be
programmed or checked.

Settings Associated with AVR and
8051 Microcontrollers

Oscillator Frequency

An external oscillator or a functional internal oscillator
must be connected in the course of AVR microcontroller
programming. The frequency setting must match the
frequency at which the device's oscillator is really
running, after eventual dividers. The maximum speed of
communication with the microcontroller then depends on
the frequency of this oscillator.

Faster Programming with Slow Clock

If this option is active, once the device is erased, the
fuses are programmed at the maximum frequency of the
internal oscillator. This allows the programmer to
communicate with the device at a faster speed. At the
end of programming, the required value of the
communication memory including the clock speed is
programmed.

This option has its effect only if the whole device is
programmed.

Inverse Reset

With this option activated, the programmer generates an
inverse reset signal.

This option is appreciated if the application includes a
reset circuit that needs an inverse signal at the input
compared to the output signal sent to the microcontroller
and if the programmer is connected via this reset circuit.

HVP

If this option is checked, the programmer uses the “high”
voltage at pin P for communication with the device.

This allows you to program a device with the external
RESET signal switched off.
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Settings Associated with 12C
Memory Chips
|12C Bus Speed

Select the maximum possible speed of the I12C bus. The
programmer switches on the internal pull-up of 2.2 kQ
while working on the 12C bus.

12C Memory Address

Select the address of the 12C memory on the bus.

4.5.5 HEX Editor Windows

HEX editors are used for displaying the content of a
memory chip to be programmed.

Different colors are used in HEX editors to differentiate
between states of different cells to make it easy to see
which cells have been read from a file, which have been
successfully programmed, etc.

Colors may be wuser-assigned. This is especially
recommended for workstations with displays/screens
displaying only a limited number of colors.

Selecting an Area

An area can be selected in a HEX editor by holding the
Shift key down and pressing the cursor keys (i.e. arrows).

Once a required area is selected, it can be filled with a
required value. The values can also be filled with RETLW
instruction. These options are available in the context
menu (opens by mouse right-click).

Code/Main Memory Editor

Menu: View - Display code/main memory

Keyboard shortcut to open the window: F10
Keyboard shortcut to close the window: Esc

The code/main memory editor displays the code/main
memory content or the content of the memory itself in
case of serial EEPROM chips (24xx, 93xx,...).

Data Memory (EEPROM) Editor

Menu: View - Display data memory

Keyboard shortcut to open the window: F11
Keyboard shortcut to close the window: Esc

The data memory editor is used for displaying the content
of the additional memory in some devices (typically
EEPROM).

Not all devices have an additional memory. This means
the editor may not be available for some devices.

Configuration Memory Editor

Menu: View - Display configuration memory

Keyboard shortcut to open the window: F12
Keyboard shortcut to close the window: Esc

The configuration memory editor displays settings that
are to be programmed in a device, but are not part of any
of the above memory types.

The configuration memory editor content depends on the
selected device type. It is necessary to get acquainted
with the device's data sheet in order to get a closer
explanation of individual options in this window.

Not all devices need configuration data. This means the
editor may not be available for some devices.

Tips for Advanced Users

Even though the configuration memory may be presented
as a set of settings, in reality it is nothing more than a
memory that can be approached cell by cell. Due to this,
it is possible to display the memory in this way.
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4.6

This can be achieved by activating Options - Program
settings - Editors - Configuration memory editor:
show cfg word instead of fuses option or by double-
clicking the configuration memory window.

The device's ID positions (do not mistake for Device ID)
can also be found in the configuration memory window. ID
positions can be programmed with values identifying the
device, such as the serial number, for example. ID
positions can always be read - even if the device is locked
against reading.

According to the recommendation of the Microchip, ID
positions should not be programmed with any value; only
a certain number of bits (typically 4) should carry data for
identification while other bits should be programmed with
the default value.

This can be achieved by activating Options - Program
settings - Editors - Mask ID positions....

Running UP from
Command Line

The UP program can alternatively be controlled from the
command line.

The program itself makes sure that it always runs in one
instance only (with one class name). Should a second
instance (with the same class name) be started,
parameters from the command line are transferred to the
first instance for execution. Up can be started in more
instances using different class name, see /wnd in List of
Parameters.

4.6.1 List of Parameters

UP.EXE [{/ask | /q}]

[{/e File with eepromm.hex | [/noel}] [{/p |[/pdiff]| [/
0]} File.hex | File.ppr] [/part device name] [/eeonly]
[/erasell/w[nd]up window class] [/cfg] [/devid] [/
blank] [/verify File] [/read File] [/s SN_programmer's]
[/[progname name] [/noboot] [/boot] [/code] [/

getpartrev]

Legend

* Text presented here in bold is to be keyed in in the
command line exactly as printed here.

* Text presented here in italics is to be replaced by the
corresponding parameter. For example, file_name
should be replaced with the real name of a file to be

opened.

* Text in braces {} separated by the | sign represents a
selection of one of the presented options. For example,
{ A| B } means “choose either A or B”.

» Text in square brackets [] presents an optional
parameter - it can be keyed in but does not have to.

* Text in quotation marks “ ” is a mnemonic.

/ask

/q /quiet

/e file

/noe

To be used linked with /p. The program
always asks if it is to continue before
launching the actual device programming
even if the program settings specify not to
ask. The dialog displays the selected device

type.

“Quiet” mode. The program does not ask
any questions. If it needs to display a
dialog, the execution finishes with an error.
See UP program return codes.

“EEPROM” file. For keying in the name of a
file with data for data memory, if needed. If
the file name contains space(s), it must be
enclosed by inverted commas.

“No EEPROM”. The program skips the
device data memory programming. If this
parameter is used for MSP430
microcontroller programming, the
information memory is erased and
programmed.
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/p file To “program”. The keyed in file will be
programmed. If the file name contains
space(s), it must be enclosed by inverted
commas.

/pdiff file To “program the difference”. The keyed in
file gets programmed by the differential
algorithm. If the file name contains
space(s), it must be enclosed by inverted
commas.

/o file To open. The keyed in file opens. This
parameter is optional. If the file name
contains space(s), it must be enclosed by
inverted commas.

/eeonly This executes the selected operation only
with the data (EEPROM) memory or only
with the information memory in the case of
MSP430.

/part name This selects the required device in
UP.

/erase This erases the device.

/wnd class name A different window class name. More
than one instance of the UP program can
be started using this parameter (running
then simultaneously). Each new instance of
the running UP must have a different class
name.

/cfg If this parameter is used in combination
with parameter /p, only the configuration
memory gets programmed. This is useful
for programming AVR microcontrollers, for
example, which can be switched to a faster
oscillator and then programmed much
faster.

/devid If this parameter is used in combination
with parameter /p, the software only
checks the device's Device ID.

/blank This checks device erasure (blank check)
and returns an error code if the result is not
OK.

/verify file This verifies the device.

/read file This reads the device and saves the read
content to the file.

/s programmer SN This makes it possible to
select a programmer by its serial number.
The serial number is to be keyed in the way
it is displayed in the UP program and
printed on the programmer bottom.
Example: 016709 or A6016709.

/progname name This makes it possible to
select a programmer by its name such as
PRESTO or FORTE for example.

/moboot This skips programming of the MSP430 boot
memory.

/boot This performs the selected operation only
with the MSP430 boot memory.

Note

PIC32 microcontrollers also have a boot memory. This,
however, uses variables and a data memory form for
programming, so it works with parameters for a data
memory and not with parameters for a boot memory. A
similar situation can be found in the information memory
of MSP430 and CC430 microcontrollers.

/code This performs the selected operation only
with code or main memory.

/getpartrev Only reads the revision of the device
and returns revision + 0x10000 as the error
code.
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Using a Project File

If you work on more than one project, it can happen that
the program is set up for a different device (or even a
different programmer if you have more) than what you
expected. To avoid such situations, it is recommended to
use project files (.PPR) that hold all the program settings
needed for programming and paths to the work files.

Examples of Use

The installation directory of the UP software contains the
“read_avr_eeprom.bat” and “set_idle_power_l.bat”
sample batch files showing the use of command line
parameters.

File Opening

up.exe file name
up.exe file.hex

up.exe "C:\My Documents\Recent Projects\PIC
\My latest project\flasher.hex"

Device Programming

up.exe /p file name
up.exe /p file.hex

up.exe /p "C:\My Documents\Recent Projects\PIC
\My latest project\flasher.hex"

4.6.2 Program Return

Codes
0 Problem-free execution.
1 File error. File not found or incorrect file

format, for example.

4.7

2 Equipment error. Communication test
failed, communication error.

3 Programming preparation error. device
cannot be erased, etc.

4 Programming error.

5 Verification error.

6 Programming failed due to a need to
communicate with user.

7 Device ID error.

8 Not supported.

0x10000 + const Revision of the device read using /
getpartrev parameter.

Note: he return value can be found in the %errorievel%
variable if working with batch files.

See the “read_avr_eeprom.bat” sample batch file in the
installation directory of UP.

Running UP by Means
of Windows Messages

The UP program can be controlled by means of messages
of the Windows operating system. The running instance of
UP executes the requested command immediately after
message receipt.

Messages must be sent to "up v1.x" class window. The
message type is always of WM_USER.

Commands are identified by “wParam” while parameters
by “IParam”.
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4.7.1 List of Commands

Unless specified otherwise, the command returns to its
return value:

0 error, failed
1 everything worked OK

Commands with a wParam of 1, 2, 3, 4, 5, 6 a 7 are
thread blocking.

wParam |lIParam |Description

0 0 does not perform anything, returns 1
1 SetForegroundWindow()
2 Maximize, SetForegroundWindow()
1 any programs everything, same return code as
from the command line
2 any programming excl. data memory, same
return code as from the command line
3 see programming incl. erasing, same return code

below as from the command line

bit 0 =1 [code/main memory

bit 1 = 1 [data memory (EEPROM)

bit 2 =1 [configuration memory

bit 3 =1 [boot memory (MSP430, CC430)

4 see reading
below

bit 0 =1 [code/main memory

bit 1 = 1 |data memory (EEPROM)

bit 2 = 1 |configuration memory

bit 3 = 1 |boot memory (MSP430, CC430)

5 see differential programming
below

bit 0 =1 [code/main memory

bit 1 = 1 [data memory (EEPROM)

bit 2 =1 [configuration memory

bit 3 = 1 |boot memory (MSP430, CC430)
6 see verification
below
bit 0 =1 [code/main memory
bit 1 = 1 [data memory (EEPROM)
bit 2 =1 [configuration memory
bit 3 =1 [boot memory (MSP430, CC430)
7 see erasing, same retumn code as from the
below [command line
bit 0 =1 |code/main memory
bit 1 = 1 |data memory (EEPROM)
bit 3 = 1 |boot memory (MSP430, CC430)
8 see BlankCheck of memory, same return code as
below [from the command line
bit 0 =1 [code/main memory
bit 1 = 1 [data memory (EEPROM)
bit 2 =1 [configuration memory
bit 3 =1 [boot memory (MSP430, CC430)
15 any presses the GO button, returns 1
16 see asks if the programmer supports the function
below
0 MCLRControl Run
1 MCLRControl Stop
2 MCLRControl Reset
8 current voltage at pin VDD
17 see performs the programmer function
below
0 MCLRControl_Run
1 MCLRControl_Stop
2 MCLRControl Reset
8 current voltage at pin VDD
return value PRESTO:
0 - unknown level
1-0V
2 -approx. 2V
3 -approx. 5V
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4 -morethan6V

return value FORTE:

-1 - measuring error

XX - measured voltage x 10
example: 33 means 3.3V

32 see UP program initialization
below
bit 0 = 1 [reload settings (reload project/ini file or
registry)

bit 1 = 1 |reload language file

bit 2 = 1 [recreate programmer (like programmer was
changed)

bit 3 =1 [reload programmer settings (like port
settings)

bit 4 =1 |reload selected device
bit 5 =1 |reload current file (.hex, .bin, ...)

bit 6 = 1 |recreate all dialog windows (adjust their size
when reloading device)

0x 0100 [refresh device specific windows
0x 0200 [refresh all editors
0x 0300 |refresh project captions

33 1 save all project settings
48 see save current file (same as Ctrl+S)
below!

bit 0 =1 [code/main memory
bit 1 = 1 |data memory (EEPROM)

Example of use

var
window: HWND,
begin
window := FindWindow('up vl.x', nil);,
Result := SendMessage (window,

WM_USER, 0, 0);
end.

bit 2 = 1 |configuration memory

bit 3 = 1 |boot memory (MSP430, CC430)

56 0 returns the handle of the UP main form

Table 8: Commands WM_USER

A message of the WM CLOSE type closes the UP
program.

1 Only parameter IParam=1 or IParam=2 are allowed for
AVR microcontrollers.
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4.8

UP_DLL.DLL Library

Thanks to this library strings can be exchanged with the
UP program.

As the library needs to communicate with UP, the
program must be running. UP_DLL cannot work on its
own.

unit up dil;
interface

Function UP_LoadFile (FileName: PChar,; style: in
teger) : integer; stdcall,

(*

* Load File (with extension .hex or .ppr);

* Loading of .ppr file can result in loading *
hex file too;

* Result codes are same like on command

* line.

*

* Style |

1; UP will be quiet on file load * errors
Style |= 2; UP will do no previous file
saving

* % %

*
N

Function UP_GetStrValue (ValueName: PChar; Value:
PChar; Size: integer): integer; stdcall,

Function UP_GetIntValue (ValueName: PChar; var Va
lue: integer): LongBool,; stdcall;,

Function UP_SetStrValue (ValueName: PChar; Value:
PChar) : LongBool; stdcall;,

Function UP_SetIntValue (ValueName: PChar; Value:
integer): LongBool, stdcall;,

Function UP_LoadFile Wnd(WndClass:PChar;, FileNam
e: PChar; style:integer) :integer; stdcall;,

Function UP_SetStrValue Wnd(WndClass:PChar; Valu

eName: PChar; Value:PChar): BOOL, stdcall;,

Function UP_SetIntValue Wnd(WndClass:PChar; Valu
eName: PChar; Value:integer): BOOL, stdcall,

Function UP_GetStrValue Wnd(WndClass:PChar; Valu
eName: PChar; Value: PChar; Size: integer): inte
ger; stdcall,

Function UP_GetIntValue Wnd(WndClass:PChar; Valu
eName: PChar; var Value: integer): LongBool, std
call;,

*

All these functions are used for changing
internal settings of UP in runtime.
UP_GetIntValue, UP_SetStrValue,
UP_SetIntValue returns nonzero if
successful

UP_GetStrValue returns amount of
characters to copy into Value string
including null terminator

If Size is less than requied size, no
characters are copied.

* % % % X X X X % %~

*
N

implementation

function UP_LoadFile; external 'up dll.dll’';
function UP_GetStrValue, external 'up dll.dll';
function UP_GetIntValue, external 'up dll.dll';
function UP_SetStrValue,; external 'up dll.dll';
function UP_SetIntValue, external 'up dll.dll';
function UP_LoadFile Wnd; external 'up dll1.dll’';
function UP_SetStrValue Wnd; external 'up dll.dl
1';

function UP_SetIntValue Wnd; external 'up dll.dl
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4.9

1';

function UP_GetStrValue Wnd; external 'up dll.dl
1’ ;
function UP_GetIntValue Wnd; external 'up dll.dl
l r ,.

end.

For further information see Appendix A UP_DLL.DLL.

Running More Than
One Instance of UP

If you need to connect more than one programmer to one
computer, a separate instance of UP must be running for
each programmer connected.

UP should be running in just one instance for standard
use. Each additional instance just sends commands from
the command line to the already running first instance or
makes it visible in another way.

However, UP can be started and run in several instances if
used together with the parameter /w and a different
window class name. Those programs (instances) having
the same window class name will communicate with each
other.

Parameters for the program controlled from the command
line are described in Running UP from Command Line.

Example of use

The first instance of UP can be started the standard way
from the start menu.

Additional instances can be started from the command
line as up.exe /w "another up", for example.

4.10

4.11

Access of More UP
Instances to One
Programmer

Only one program or utility can access one programmer
at any one time.

The operating system takes care of the access rights of
programmers connected to the USB interface.

If UP is running, the operating system does not allow any
other program to access the selected programmer as UP
needs to continually check the GO button state and the
voltage on the feeding pin.

UP can temporarily be prohibited to access the
programmer and the programmer freed this way for
another application. This can be done by choosing
Options - Select programmer. As long as this dialog is
open, another program can access the programmer. The
data the system works with in HEX editors does not get
lost by closing this dialog window.

Updating UP

If a newer program version is available on the web, it is
recommended to update the existing version as it may
eliminate known bugs or make the programming
algorithm for a particular device more efficient.

New versions also add newly supported types of devices.

Updates are free and are very easy. You can download a
new program version from  http://www.asix.net/
dwnld_up.htm and simply install it over the previous one
by running the installer and clicking the Next button till it
finishes.

You do not have to worry about losing the settings you
created in your current program version. The installation
preserves all of them.
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4.12

You can set an automatic check for newer versions on the
web in Options - Program settings - Others.

Appendix A UP_DLL.DLL

This appendix deals with the names of settings and
values of functions in the UP_DLL.DLL library.

Please look at the sample batch files in UP installation
folder for better understanding.

The following information is provided only for experienced
users and does not provide any guarantee.

4.12.1 Data Types

string is string
integer signed 32bit value

boolean accessed like integers; 0 is false, other
value is true

4.12.2 List of UP variables
Prog.LoadFileBfgProg

boolean

If true, current file is reloaded before device (or its part) is
programmed.

Prog.LoadFileBfgProgWarnMod

boolean

If true, the program warns when it is set to reload current
file before programming and data in some editor have
been manually modified.

Prog.LoadFileBfgProgWarnOnNoChange

boolean

If true, the program warns when it is set to reload current
file before programming and the content of the loaded file
has not changed from the previous programming.

File.AutoCheck

boolean

If true, current file is periodically tested for changes.

File.LoadOnModify

boolean

If true, when change is detected, question pops up.

FileLoad.ClearData
FileLoad.ClearCfg
FileLoad.ClearlD

FileLoad.ClearCode

boolean

If true, the contents of code memory is erased (in UP
memory) before new file is loaded;

all cells not stored in the file will have its default (blank)
state.

Part.Name
string

Selected device name

Prog.Name
string

Selected programmer name

Possible values are PREST, FORTE.

Prog.PortBase
integer

Serial number of programmer
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Prog.UseOnlyThisSN

boolean

If true, the SN saved in the up.ini is always used regardles
of the SN contained in a project file.

LanguageFile
string

Relative path to used languange file

Project.File
string

Project file path

Project.Present
boolean

Project. Template
boolean

If true, the user is asked for project name before its
saving.

HexFile.File
string

Opened current file path

HexFile.Present
boolean

HexFile.IHex
boolean

If true, the file with extension different from .HEX or .BIN
is loaded as HEX file.

HexFile.Template
boolean

If true, the user is asked for name before saving.

HexFile.SaveVoid
boolean

If true, empty cells are saved, too.

HexFile.AskForBinEndian

boolean

If true, the user is asked if the loaded BIN file should be
loaded as Little or Big endian.

HexFile.BinLittleEndian

boolean

If true, the loaded BIN file is loaded as Little endian.

HexFile.LoadDataAuto

boolean

If true, with file is loaded also a separate file for data
memory.

HexFile.LastDataFile

string

Path of a separate file for data memory.

HexFile.DatalHex
boolean

If true, the file for data memory with extension different
from .HEX or .BIN is loaded as HEX file.

Prog.QBfrEraseFlash

boolean

Question before erasing flash devices

Prog.QBfrProgFlash

boolean

Question before programming flash devices

Prog.QBfrProg

boolean
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Question before programming OTP devices

Prog.QBfrDiffProg

boolean

Question before differential programming (of flash
devices)

Prog.QBfrProgCP

boolean

Warning before programming device with some kind of
protection

Prog.CloseStatOnGoodAct

boolean

If true, status window will be automatically closed after
read/verify etc... without errors.

Prog.CloseStatOnGoodProg

boolean

If true, status window will be automatically closed after
programming without errors.

Prog.BeepOnGoodProg

boolean

If true, program makes a sound on successful
programming.

Prog.BeepOnBadProg

boolean

If true, program makes a sound on unsuccessful
programming.

Prog.SoundsOff

boolean

If true, all sounds of the program are switched off.

Prog.SkipBlankForCfg

boolean

If true, no blank check of part is performed before
programming of configuration space.

Prog.SkipBlankCheck

boolean

If true, no blank check of device is performed before
device programming.

Prog.SkipErase

boolean

If true, no erasing is performed before device
programming.

Prog.SkipEraseData

boolean

If true, no erasing is performed before only data memory
programming.

Prog.SkipLastFFVerify

boolean

If true, verification of empty FF positions at the end of the
programmed memory is not preformed.

Prog.SkipVerify

boolean

If true, no verification is performed after programming.

Prog.DoubleVerify

boolean

If true, verification on two supply voltages is performed
after programming. Supported by FORTE with internal
supply voltage only.

Prog.DoubleVerifyV1

integer

Defines supply voltage size for the first verification, the
value is in volts x 10.
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Prog.DoubleVerifyV2

integer

Defines supply voltage size for the second verification,
the value is in volts x 10.

Serial
integer
0 no serial numbers
1 serial numbers are from external file
2 serial numbers are calculated
Serial.Step
integer

Step of serial numbers

Serial.File
string

File name of external file with serial numbers

Serial.File.Next
string

Label of serial number

Serial.Length

integer

If serial number is computed, serial number length
(digits)

Serial.Actual

(unsigned) integer

If serial number is computed, actual computed serial
number (if decimal, coded as BCD)

Serial.ASCII

boolean

If serial number is computed, if true, serial number is
stored to device as ASCII characters.

Serial.SaveTo

integer
1 code/main memory
2 data memory
4 ID positions

Serial.Retlw
boolean

If serial number is computed, if true, memory cells are
filled with retlw instructions.

Serial.Addr

integer

If serial number is computed, address where to save

Serial.CPW

integer

If serial number is computed, chars per word

Serial.Base
integer

If serial number is computed, base of serial number, can
be only 10 or 16

Serial.Succ
integer

next serial number is

0 same

1 incremented

2 decremented
3 random (LSFR)
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Serial.Order

integer
0 HiLo hilo
1 hilo HiLo
2 LoHi lohi
3 lohi LoHi

Serial.Write.BeforeProg
boolean

If true, current serial number is "written" into opened HEX
editors just before programming the device.

Serial.Write.AfterProg

boolean

If true, current serial number is "written" into opened HEX
editors after successful programming.

Serial.Succ.AfterProg
boolean

If true, next serial number is generated after successful
programming.

Serial.LogSN

boolean

If true, the result of programming is logged to a selected
file.

Serial.LogFile

string

File name of a file where the result of the programming
will be logged.

ICSP.LongTime

boolean

If true, longer times for switching Vcc are taken.

ICSP.LongTime. Time.SwOn

integer

Time to wait after Vcc is switched on in microseconds.

ICSP.LongTime.Time.SwOff

integer

Time to wait after Vcc is switched off in microseconds.

SpecSettings.PREST.Power

integer
0 idle power supply is None / External
1 idle power supply is Internal 5 V

SpecSettings.PREST.ProgPower

integer

0 power supply during programming
External 2.7to 5.5V

1 power supply during programming
Internal 5 V

SpecSettings.PREST.i2cSpeed

integer

0 100 kHz

1 500 kHz

2 1 MHz

3 Maximal
SpecSettings.PREST.i2cAddr
integer

0 first suitable address or N/A

1 second suitable address
etc...
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SpecSettings.PREST.LVP

integer

0 HVP method

1 LVP method
SpecSettings.PREST.PICAIlg
integer

0 automatic selection

1 assume VDD =5V

2 assume VDD <5V
SpecSettings.PREST.UsePE
boolean

If true, PE (programming executive) is wused for
programming of PIC MCUs.

SpecSettings.PREST.PIC32MZ_BootProg

integer

0 Lower Boot alias

1 Boot Flash 1 and 2
SpecSettings.PREST.PSoCAlg
integer

0 automatic selection

1 assume VDD > 3.6 V

2 assume VDD =< 3.6 V

SpecSettings.PREST.PSoCRSTInit

integer
0 Reset mode

1 Power cycling

SpecSettings.PREST.MSP4300sc

integer
0 Calibrated internal RC oscilator

1 Not calibrated internal RC oscilator

SpecSettings.PREST.MSP430speed

integer

0 Normal

1 Slow

2 Slowest
SpecSettings.PREST.MSP430EraseSegme
ntA
boolean

If true, MSP430 Segment A is erased.
SpecSettings.PREST.SPI_Flash_Freq

integer

0 3 MHz
1 1.5 MHz
2 750 kHz

SpecSettings.PREST.AVRXTAL.CLK

SpecSettings.PREST.AVRXTAL.RPT

integers
represent maximum AVR oscillator frequency
values can be found in *.Ing files at item

MainForm.PRESTSpecForm.ComboAVRXTAL.xxx.ltems
where xxx is minimum divisor of system clock of selected
AVR's SPI module. This is 2 for new AVRs, 3 and 4 for
older AVRs and 24 for Atmel's 8051 arch. processors.

These settings can be found in ini file too at
[SpecSettings.PREST], XTALRpt and XTALCIk.
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SpecSettings.PREST.AVRXTAL.AutoClk

boolean

If true, faster programming with slow clock is used for
AVR MCUs.

SpecSettings.PREST.AVRRSTInverse

boolean

If true, the reset signal polarity is assumed to be inverse
in comparison with standard polarity of the reset signal of
the selected chip. It is supported with AVR and 8051
devices.

SpecSettings.PREST.AVRHVP

boolean

If true, high voltage method is used for AVR MCUs, it is
supported for AVR TPl interface only.

SpecSettings.FORTE.UVCCLevel

integer

Defines the size of the internal supply voltage provided by
FORTE programmer. The value is in volts x 10.

SpecSettings.FORTE.Power

boolean

If true, idle power supply is provided by FORTE
programmer.

SpecSettings.FORTE.ProgPower

boolean

If true, the supply voltage during programming is
provided by FORTE programmer.

SpecSettings.FORTE.LVP

integer
0 HVP method
1 LVP method

SpecSettings.FORTE.UsePE

boolean

If true, PE (programming executive) is wused for
programming of PIC MCUs, when programmed by FORTE
programmer.

SpecSettings.FORTE.PIC32MZ_BootProg

integer

0 Lower Boot alias

1 Boot Flash 1 and 2
SpecSettings.FORTE.PSoCAlg
integer

0 automatic selection

1 assume VDD > 3.6 V

2 assume VDD =< 3.6 V

SpecSettings.FORTE.PSoCRSTInit

integer
0 Reset mode

1 Power cycling

SpecSettings.FORTE.MSP4300sc

integer
0 Calibrated internal RC oscilator

1 Not calibrated internal RC oscilator

SpecSettings.FORTE.MSP430speed

integer

0 Normal
1 Slow
2 Slowest
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SpecSettings.FORTE.MSP430EraseSegme
ntA

boolean

If true, MSP430 Segment A is erased.
SpecSettings.FORTE.MSP430Interface

integer

0 JTAG

1 SBW
SpecSettings.FORTE.ARMFreq
integer

The value specifies the frequency of connected oscillator
or crystal. This value is used for programming of
ARM7TDMI.

SpecSettings.FORTE.ARMOscType

integer

0 Crystal
1 Ext. Clock
2 Int.RC 32 kHz

SpecSettings.FORTE.ARMCommFreq

integer

Selects communication frequency between FORTE
programmer and the programmed chip. The frequencies
are same as stated in the "Communication frequency"
ComboBox in UP. 0 means the highest frequency, 1 is
lower and so on.

SpecSettings.FORTE.SPI_Flash_Freq

integer

Selects communication frequency between FORTE
programmer and the programmed chip. The frequencies
are same as stated in the "Communication frequency"
ComboBox in UP. 0 means the highest frequency, 1 is

lower and so on.
SpecSettings.FORTE.AVRXTAL.DELAY
integer

represents maximum AVR oscillator frequency
value can be found in *.Ing files at item

MainForm.PRESTSpecForm.ComboAVRXTALPresto2.xxx.It
ems where xxx is minimum divisor of system clock of
selected AVR's SPI module. This is 2 for new AVRs, 3 and
4 for older AVRs and 24 for Atmel's 8051 arch.
processors.

This setting can be found in ini file too at
[SpecSettings.FORTE], XTALCIk.

SpecSettings.FORTE.AVRXTAL.AutoClk

boolean

If true, faster programming with slow clock is used for
AVR MCUs.

SpecSettings.FORTE.AVRRSTInverse

boolean

If true, the reset signal polarity is assumed to be inverse
in comparison with standard polarity of the reset signal of
the selected chip. It is supported with AVR and 8051
devices.

SpecSettings.FORTE.AVRHVP

boolean

If true, high voltage method is used for AVR MCUs, it is
supported for AVR TPl interface only.

SpecSettings.FORTE.ATxmegalnterface

integer
0 PDI
1 JTAG

SpecSettings.FORTE.i2cSpeed

Page 73



4.13

integer

0 100 kHz

1 400 kHz

2 1 MHz

3 Maximal
SpecSettings.FORTE.i2cAddr
integer

0 first suitable address or N/A

1 second suitable address
etc.

Appendix B: Use of ICSP

ICSP (In-Circuit Serial Programming) is a method of PIC
microcontroller programming making it possible to
program devices already placed on PCBs.

Two different algorithms may be used for PIC
microcontroller programming: HVP (using programming
voltage on pin -MCLR/VPP) or LVP (using the LVP pin).

The LVP programming algorithm can be disabled in the
device's configuration word. Microcontrollers have the
LVP algorithm enabled from the production, therefore
their PGM input needs to be treated during the first
programming (PGM input must be in log.0 for the time of
programming by means of the HVP algorithm).

Note: Not all devices have the PGM pin.

4.13.1 Pins Used for
Programming

This chapter describes how to treat pins in the ICSP
programming mode in accordance with the programming
algorithm.

HVP Algorithm

* PGM pin (if the device has one) must be maintained in
log. O!!

* -MCLR/VPP must be separated from the resetting
circuits (with a 10 kQ resistor, for example).
A programming voltage is supplied to this pin P(VPP) for
programming. The leading edge and the voltage level at
VPP must not be influenced by the application. The
PRESTO programmer supports only fixed voltage of
13 V on pin P(VPP) in contrast to adjustable voltage
within a range of 6.5 V to 17 V supported by FORTE.
Please check limit voltage value on pin -MCLR/VPP of
the PIC device to be programmed by PRESTO.

* RB6 and RB7 pins must not be influenced by the
application during programming.

LVP algorithm (without VPP)

* RB6, RB7, PGM and -MCLR/VPP pins must not be
influenced by the application during programming. All
pins are in various logical levels during programming.

Loading of Different
Programmer Pins

The maximum current drawn from I/O pins, from pins
P(VPP) and VDD can be found in the Technical
Specification.

OTP (One-Time Programmable) devices have a
considerably higher current consumption on pin P(VPP)
than devices with a FLASH memory. Therefore the
application should not have any additional current
consumption at pin P(VPP) in case of OTP.

Data pins may have their signals changing at a speed of
several MHz, so the application must not influence the
signals in any significant way.
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4.13.2 Power Supply
Options

Connecting the shared data and power supply ground

(GND) is obviously necessary for all cases. The
microcontroller being programmed can be fed:

» externally from an application
* internally from a programmer

The external power supply from the application cannot be
used for some types of microcontroller having the -MCLR/
VPP pin alternatively configurable as an I/O.

The internal power supply can be used only in cases
where the application does not draw too much current
from programmer's feeding pin (VDD). The maximum
allowed current consumption can be found in the
Technical Specification.

Both PRESTO and FORTE programmers feature an
overcurrent protection. PRESTO has a software protection
in which an output gets disconnected by the running UP
program having detected an overload. FORTE has a
hardware protection, which does not depend on the
control software.

The programmer switches the power supply off if the
maximum load is substantially exceeded for a certain
time (this time is adjustable). PRESTO checks for the
overload state the whole time the power supply is
connected.

Support for an external power supply is integrated in both
PRESTO and FORTE hardware. The programmer feeds the
input and output circuits with a voltage connected to pin
VDD. The voltage may be lower than 5 V.

Advice

When designing the process, please pay special attention
to the type of device to be programmed - if it can be not
only operated but also programmed at a voltage lower
than5 V.

Power Supply Capacities in
Application

If there are capacities present at the application's power-
supply pin that would slow down the power on/off
switching and application is fed from programmer during
programming, longer charging/discharging times need to
be set in UP. In other case UP will probably announce
overcurrent on VDD pin.

An approximate time that should be set in the program:
t[us] = 2.5 x C[uF] x R[Q].

The equivalent resistance is presented in table following
table:

Programmer |Charging current Discharging current
PRESTO Corresponds to 50 Q Corresponds to 1 kQ
FORTE Corresponds to 50 Q Corresponds to 27 Q

Table 9: Equivalent resistance of pin VDD

Example

The necessary charging time for an application with
a 33 uF capacitor programmed with PRESTO:

2.5 %X 33 x 50 = 4125 s
discharging:
2.5 X 33 x 1000 = 82.5 ms.

For further information on the setting see » Delay for VDD
switching on/off when supplied from programmer.
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Notes

* An error may occur if UP cannot program the calibration
word or if a fault occurs during Device ID reading, UP
warns about an overcurrent at VDD, etc. This may be
eliminated by prolonging the charging/discharging time
in the » Delay for VDD switching on/off when supplied
from programmer option - up to several seconds.

* If UP points out an overcurrent error at VPP, a shorter
ICSP cable may help (its maximum length is 15 cm).

4.13.3 ICSP Connector

All ASIX programmers use a unified connector with
2.54 mm spacing of pins for programming with the ICSP
algorithm.

This connector has 8 pins with 7 signals. Not all signals
are always needed for the programming itself.

For further information on connecting a device to the
programmer see Connection Examples.

Pin No Signal Programming connector
1 -MCLR P/VPP

2 not used (key)

3 VCC VDD

4 GND GND

5 RB7 D /DATA

6 RB6 C/CLOCK

7 not used

8 RB3/RB4/RB5 L/LVP

Table 10: ICSP connector

The following drawing illustrates the recommended
connection of -MCLR/VPP pin found in Microchip
microcontrollers for device programming through the
ICSP interface.

VDD

10k

100n
MCU PIC T

Programmer
-MCLR/VPP

VDD —
GND —
DATA
CLK

LvP

Fig.32: Recommended connection of -MCLR/VPP pin

4.14 Appendix C: Intel-HEX

File Format

This appendix describes the format of Intel-HEX files used
by UP for data reading and saving. .hex is the typical
extension for such a file.

4.14.1 Supported
Alternatives of HEX
Files

UP supports 2 basic alternatives of Intel-HEX files:

* "basic", sometimes also 8-bit Intel-HEX File (e.q.
Microchip MPASMWIN generates this file with parameter
INHX8M).

» "extended", sometimes also 32-bit Intel-HEX File (e.g.
Microchip MPASMWIN generates this file with parameter
INHX32).
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4.14.2 Description of
Intel-HEX File Format

Intel-HEX are text files consisting of lines.
Each line has the following structure:
:LLAAAATTDDDD. . .CC

Each line in a file must start with this
character (colon, 0x3A).

LL Length of record (number of DD fields).
AAAA Address of record's first byte.
TT Record type. The types may be:
00 - Data
01 - End of file. Each file must finish with
this record.

02 - Extended segment address. (32-bit
Intel-HEX only)

04 - Extended linear address. (32-bit
Intel-HEX only)

There are also other types like 03 and 05, which are
ignored by UP while reading and not used for saving.

DD Record data. The number of bytes must be
exactly LL.
CC Checksum. The check sum is computed as

a binary supplement to the sum of all
values on the line.

Data Record

A line with the configuration memory of a 14-bit device is
used here as an example.

:02400E00413F30

02 Record length. The configuration memory
size is one word = 14 bit = 2 byte (byte
alignment).

400E Record address. The configuration memory
address is the word 2007h addressed by
bytes, i.e. 400Eh.

00 Record type = data
413F Record data. Configuration word =3F41h
30 Check sum. 30 = 02 + 40 + OE + 00 + 41

+ 3F = xxD0; neg DO = 30

End of File

The only acceptable alternative of the End of file line is:

:00000001FF

Extended Linear Address

Only files that need to address more than 64 kB of the
addressed space contain this line.

For example, processors of the PIC18F family have their
configuration memory saved at the address 0Ox 30 00 00
00.

If this address needs to be used, it is necessary to insert a
line in the .hex file specifying the extended linear
address, i.e. the upper 16 bites of the address. The lower
16 bits are read from the line with the data record.

:020000040030CA

This line selects the configuration memory of PIC18F
family devices.

The extended segment records specify the segment, i.e.
bits 19-4 of the address, which are then added to
addresses from the data records (offset).
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Saving Device Type in .hex File

Users frequently mistook the selected device type for the
device type for which the .hex file was saved. To
eliminate this, UP contains a function allowing you to save
the device type in a file.

The program adds one more line below the End of File:
#PART=.... The absolute majority of programs working
with Intel-HEX files ignore this line, but such a modified
file cannot be considered as complying with the Intel-HEX
format.
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5
PRESTO.DLL Library

The presto.dll library has been designed for working
together with the PRESTO programmer.

The implemented functions allow you to set logical levels
at different programmer's pins as needed or to read their
state. Various communication protocols can be created
thanks to this.

The function QsetPins() is provided for controlling all
pins that can work as an output, while the function
QGetPins() serves for reading pins working as an input.

The function QSendByte() allows you to quickly send an
SPI Byte to data and clock pins. If reading is needed at
the same time, use the QsendByte_Outin() function.

In addition there are functions for setting the
programmer's characteristics, controlling the voltage or
reading the return values.

This library can be used with all revisions of the PRESTO
programmer regardless of the hardware version.

The functions implemented in the presto.dll library are
described in detail in a separate document devoted to
this library.
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6

JTAG PLAYER

6.1

JTAG PLAYER is a utility designed for programming
devices with the JTAG interface by means of PRESTO or
FORTE programmers.

This utility is not part of the UP software installation pack
but it can be downloaded separately from http://
www.asix.cz/dwnld_jtag-svf-player.htm

JTAG PLAYER is localized only in English.

JTAG Device
Programming

Having started JTAG PLAYER, select your programmer in
Options » Select Programmer.

If you cannot see your connected programmer in the
dialog window, check if the green ON-LINE LED on the
programmer is on. If so, make sure thatanother software
is not communicating with the programmer.

Program the device by choosing File - Open&Process.
The file to be programmed must be in SVF/XSVF format.
For more information on the file format see SVF File or
XSVF File.

If an error occurs during the programming process, check
the connection between the programmer and the
application. In addition, check the presence of a feeding
voltage.

Important warning

A power supply voltage from an external source must be
present during programming that utilizes the JTAG
interface. The programmer does not feed the application
in this case.

6.1.1 SVF File

SVF (Serial Vector Format) is a file used for describing
high-level operations on the IEEE 1149.1 bus.

Serial Vector Format (.svf) is the recommended file
format for all the testing and programming except
for Xilinx CPLD XC9500. The Xilinx Serial Vector
Format (.xsvf) is recommended for Xilinx CPLD XC9500.

Examples of How to Create SVF
Files

This chapter presents methods of creating an SVF file for
different types of device.

Atmel AVR (e.q.
Programming

ATmegal28)

Generate an SVF file using the avrsvf.exe program
available at the ATMEL website in the “Tools & Software
of AVR 8-bit RISC MCUs"” section.

Example:

avrsvf -datmegal?28 -s -e -ifmyfile.hex -pf -vf -
ovmyfile.svf -mp

This example shows how to create an SVF file from the
myfile.hex file. The final SVF file is then used by
jtagplay.exe for erasing, programming and verification.
Run avrsvf -h for more information.

The device must be in the reset state during
programming.
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Notes

Some AVR devices do not support page by page
programming. In such a case, the SVF file must be
created without the -mp parameter.

Lattice CPLD Programming

SVF file can be created from a .JED file using ispVM
System. This program is part of the ispLEVER Classic
system, which is available at the Lattice website.

Altera CPLD Programming

The QUARTUS Il program by Altera can generate SVF files
if it is set up so in the menu.

Such an SVF file, however, cannot be used as it is due to
a wrong Silicon ID. According to Altera, SVF files
generated by their software are assumed only for ATE
(Automatic Test Equipment) programmers and Altera
does not consider supporting others.

However, such an SVF file can be manually modified to
suit our needs. In order to do so, delete the "CHECKING
SILICON ID" section in the SVF file or mark it as a non-
executable comment.

State of .svf File
Implementation

The SVF file support has been implemented in accordance
with the "Serial Vector Format Specification, Revision E"
available at www.asset-intertech.com/support/svf.html
with the following limitations:

* PIO a PIOMAP commands are not implemented.

* HDR+SDR+TDR / HIR+SIR+TIR length is limited to
2731 bits.

* Supported TCK frequencies are 3 MHz, 1.5 MHz,
750 kHz and fragments of 1 MHz starting at 500 kHz for
PRESTO. FORTE adds 15 MHz, 10 MHz and 5 MHz on top
of these.

* RUNTEST MAXIMUM max_time SEC parameter is
ignored.

* UNTEST run_count is limited to 2731/3 (approximately
715 million).

* RUNTEST min_time SEC is limited to 2731/3 ms
(approximately 715 seconds).

* TRST and RUNTEST SCK - these commands share the
same configurable P/VPP pin of both the PRESTO and
FORTE programmers and can never be used together.

6.1.2 XSVF File

XSVF (Xilinx Serial Vector Format) is a file used for
describing high-level operations on the IEEE 1149.1 bus
extended by Xilinx.

XSVF is recommended for Xilinx CPLD XC9500.

Examples of How to Create
XSVF Files
Xilinx CPLD Programming

To create an XSVF file, use the iMPACT program available
at the Xilinx website.

Choose Prepare Configuration Files - Boundary-
Scan File - XSVF File in the Operation Mode
Selection dialog window that opens after the iIMPACT
program starts. Run all operations (Erase, Program,
Verify, Test...) the same way as if a programmer was
connected (e.g. Xilinx Parallel Cable). Then save the new
file and close iIMPACT. Running the created XSVF file will
perform the recorded operations.

We do not recommend using an SVF file for
programming devices of the Xilinx XC9500 family, as the
algorithm for XC9500/XL/XV device programming cannot
be correctly described in the SVF format.
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State of XSVF File
Implementation

The XSVF file support has been implemented in
accordance with the "XAPP503, Appendix B: XSVF File
Format" specification available at the Xilinx website with
the following limitations:

¢ XSETSDRMASKS, XSDRINC and XSIR2 commands are
not implemented.

* Only the XSVF file format is recommended for
programming the Xilinx XC9500/XV/XL families.

We seriously recommend using an SVF file for all
architectures except XC9500/XV/XL. For XC9500/XV/XL
programming, the wuse of the XSVF format is
recommended as the SVF format does not include the
XREPEAT command, which is necessary for XC9500/XV/XL
programming.

Warning: Executing a file containing the XREPEAT
command may be very slow.

6.2

6.1.3 Programming
Connector

The following table describes the functions of PRESTO's
and FORTE's pins for programming by means of the JTAG

interface.

PRESTO FORTE Function

VPP P SCK (System Clock)/User defined state
during file execution and after.

- - Not connected pin (key)

VDD VDD Feeding of I/O buffers

GND GND Ground of I/O buffers

MOSI D JTAG TDI (Test Data In)

CLOCK C JTAG TCK (Test Clock)

MISO I JTAG TDO (Test Data out)

LVP L JTAG TMS (Test Machine State)

Table 11: JTAG programming connector

Settings

This chapter explains the meaning of different settings in
Options - Program Options.

6.2.1 Default TCK signal
frequency

This frequency of the TCK clock is used until the JTAG
Player reaches the first FREQUENCY command in the SVF
file or until the FREQUENCY with the "default" value is
reached.

The XSVF file format does not support the FREQUENCY
default command. Therefore frequency defined by
Default TCK Signal Frequency parameter is applied to
all operations.
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The maximum frequency is 3 MHz for the PRESTO
programmer and 15 MHz for FORTE.

If the Ignore FREQUENCY commands option is selected,
the programmer applies only the frequency set by the
user and ignores all FREQUENCY commands.

6.2.2 Fast Clocks Option
(FORTE only)

This option is available only for the FORTE programmer.

According to the JTAG specification, the signal at TDI is
sampled at TCK's rising edge. However, should a higher
frequency be required (around 5 MHz or more), it may be
useful to change the moment of sampling from the rising
edge to the falling edge by shifting it by 1/2 of the TCK
period. To do so, choose Fast Clock Option.

6.2.3 RUNTEST without
run_count (SVF only)

The programmer should stay in the specified state for the
specified time and generate the clock signal on TCK while
executing an SVF file.

The specified time can be exceeded, but it slows the
programming process down. Even though it is not
supported by the SVF specification, many programmable
devices allow stopping the TCK clock during this time.

The programmer's ability to keep accurate time needs to
be considered. A high level of accuracy cannot be
achieved if the maximum frequency is used (the
programmer can guarantee respecting the min_time SEC
parameter only). A higher accuracy can be achieved with
slow clock (~100 kHz). If the clock signal is not used at
all, the programmer is capable of following the min_time
SEC parameter almost exactly.

Three possibilities are available considering these facts:

* no clock on TCK

* slow clock on TCK (~100 kHz)
» default speed clock on TCK

Example: "RUNTEST 3E-3 SEC;" means "Generate clock on
TCK for at least 3 ms".

6.2.4 RUNTEST Timing
Multiply (both SVF
and XSVF)

Recommended values:

 for accurate timing specified in the SVF or XSVF file: 0%
(no added time)

» for XC9500(XL) family: 100% or more
» for Atmel AVR (e.g. ATmegal28): 25%

6.2.5 RUNTEST with
run_count and no
timing
(both SVF and XSVF)

This command should be interpreted as the minimum
frequency on TCK.

Yet some SVF file generators (such as Xilinx iMPACT, for
example) use this command as waiting time and assume
a frequency of 1 MHz. For such cases the use of "interpret
as RUNTEST min_time with scale 1 MHz" setting is
recommended.

JTAG Player Behavior When Reaching RUNTIME
Command With MINTIME Specification

(This concerns only SVF files as the RUNTEST alternative,
which is usable in XSVF XRUNTEST run_count cannot
specify time.)
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* The RUNTEST command containing run_count and
specifying min_time is executed at the currently
running TCK frequency. Therefore the command can
take much more time than what is specified in
min_time.

* The RUNTEST command containing run_count and
specifying max_time is executed at the currently
running TCK frequency. As the programmer cannot
respect the “deadline” specified in the max_time
parameter, this parameter is ignored.

6.2.6 VPP PRESTO /P
FORTE pin usage
while running test
(file) / after test
completion

The selection of the VPP / P pin function: TRST or SCK as
described in the SVF file or user-defined output levels.
(This is useful to keep the device in the reset state during
file execution.)

6.2.7 Default Settings

The JTAG Player features several default settings intended
primarily for use in connection with FORTE, but not with
PRESTO. Feel free to change these settings if the default
values do not suit your application.

Default Settings for FPGAs

Default TCK frequency: 15 MHz; Ignore FREQUENCY
commands

Fast Clock Option (FORTE only): 5 MHz and above

RUNTEST without run_count (SVF only): default
speed clock on TCK

RUNTEST timing multiply (both SVF and XSVF): 0%

RUNTEST with run_count and no timing (both SVF
and XSVF): interpret as RUNTEST min_time with scale
1 MHz

VPP PRESTO / P FORTE pin usage while running test
(file): Tristate

VPP PRESTO / P FORTE pin usage after test
completion: Tristate

Default Settings for XC9500

Default TCK frequency: 5 MHz; Ignore FREQUENCY
commands

Fast Clock Option (FORTE only): 5 MHz and above

RUNTEST without run_count (SVF only): slow clock
on TCK (~100 kHz)

RUNTEST timing multiply (both SVF and XSVF):
100%

RUNTEST with run_count and no timing (both SVF
and XSVF): interpret as RUNTEST min_time with scale
1 MHz

VPP PRESTO / P FORTE pin usage while running test
(file): Tristate

VPP PRESTO / P FORTE pin usage after test
completion: Tristate

Default Settings for AVR:

Default TCK frequency: 1 MHz; Ignore FREQUENCY
commands

Fast Clock Option (FORTE only): 5 MHz and above

RUNTEST without run_count (SVF only): default
speed clock on TCK
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6.3

RUNTEST timing multiply (both SVF and XSVF):
25%

RUNTEST with run_count and no timing (both SVF
and XSVF): interpret as RUNTEST min_time with scale
1 MHz

VPP PRESTO / P FORTE pin usage while running test
(file): Tristate

VPP PRESTO / P FORTE pin usage after test
completion: Tristate

Running JTAG Player
from Command Line

SVF & XSVF JTAG Player can be run from the command
line for more comfort especially during debugging. The
following parameters apply:

jtagplay.exe [-p] [-f filename] [-i inifile] [-
c] [-cc] [-s serial]

-p automatically executes the file specified in
the -f filename parameter

-f filename specifies SVF / XSVF file to be executed
-i inifile ini file containing settings

-C closes the program if the file has been
executed without errors

-CcC closes the program even if the file has been
executed with error(s)

-s serial  uses PRESTO or FORTE programmer of the
specified serial number

-forte uses FORTE, not PRESTO
Return Codes

The jtagplay.exe program returns the following return
codes:

execution of the last file had no errors

an error occurred during execution of the

last file

execution of the
started

last file could not be
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7

TROUBLE-SHOOTING

7.1

This chapter describes how to proceed if experiencing
difficulties with device programming. It also describes
testing utilities for PRESTO and FORTE programmers
designed to check if the programmer is in good condition
or damaged. Please go through all the tips and tricks
before you send your programmer to a service shop.

The testing utilities are not part of the UP software
installation, but they can be downloaded separately from
http://tools.asix.net/supp_testers.htm.

Tips and Tricks

Should you experience difficulties with programming, we
recommend checking the following points:

* Check the microcontroller and programmer connections
according to the description in Connecting to
Application. Even though it may seem trivial, it is
recommended to check the connection twice and to
assume the second time that the link does not always
lead where you want it to or it leads to more than one
point.

* If a crystal or other auxiliary devices are used for
programming, (typically pull-down or pull-up resistors),
check if their values and connections are correct.

* It is advisable (and often necessary) to have blocking
capacitors at the power supply of the device to be
programmed.

* If the device to be programmed has more than one
power-supplying pin, all of them must be really fed. It is
often recommended to check their voltage with a
voltmeter.

* Use of the latest version of UP is recommended. If you
are still using an older version, an update is
recommended.

* Are you programming a new device or has it been
previously programmed? If so, the problems may be
caused by unsuitably set fuses in the device.

* The length of the ICSP cable should not exceed 15 cm.

* Make sure that there is no additional capacity present
at the programming (data) pins. Consider if circuits on
the programming pins could cause too large a load for
programming.

* It is important that the crystal or the communication
speed settings reflect the reality in devices that need
that settings.

* Some devices may be programmed using several
different methods. Programming problems may be
caused by selecting a different programming interface
or a different programming mode than the ones that
the application is prepared for.

If none of the above tips help to eliminate the problem
and if it absolutely sure that the device to be
programmed is not faulty, the fault may lie in the
programmer.

To easily find out whether the programmer is in order or
not, you can use the testing utilities described in the
following chapters.

PRESTO Tester

he PRESTO Tester utility easily tests the “health
state” (usability) of the PRESTO programmer right at the
customer's site.

In order to run it successfully, only one PRESTO
programmer may be connected to the control PC and its
drivers must be correctly installed. This is confirmed by
the green LED being on.
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7/ Logic Tester - PRESTO SN: A6018208 =13
File Test
Fin [ A SD& / DATA 4 MOSI Fin L / LVF
(%) Trigtate (%) Triztate
i Logic 0 ) Logic 0
" Logic 1 (" Logic 1
[]Enable Pull-Up
FReads: 0 Reads 0
Finl /501 / KIS0 Pin C / SCK. / CLE
%) Tristate
Readsz 0 {1 Lagic O
) Logic 1
BirEsR PR WD & AlLl= Options
%) Tristate B from LSE
{3 Logic O []"active" LED
{7 Logic 1
O 13 Reads: 5
Reads: 0

Fig.33: Tester PRESTO

After you start the tester, make sure that the
programmer's output buffers are fed. You can either use
the 5V from USB option or connect an external power-
supply voltage to the VDD pin. The level of detected
voltage is displayed in the lower part of the VDD&AUX
panel.

Basic communication with the programmer can easily be
recognized by the Active diode being on. You can also
use the Test - USB Flood Test menu option, which
tests the USB communication with the programmer in
both directions.

The programmer's serial number is displayed in the
window title bar. This number is necessary for any
communication with the service shop. You can also find
this number on the bar code label attached to the
programmer bottom.

Now you can switch logical levels for individual output
pins (pins P, D, D and L) and check the output signal

quality using a voltmeter. At the same time, the input
pins (pins P, D, | and L) indicate what logical level is
currently seen by the programmer.

In addition, a pull-up resistor may be connected to pin D.
This means that if its output is in the Tristate mode, pin D
starts reading log. 1.

The programming voltage of 13V can be connected to
the output of pin P.

If everything seems to be in order, but the device still fails
to get programmed, it is recommended to check the
application connection according to instructions for
connecting a microcontroller to the programmer.

If in doubt as to whether the programmer is in order or
faulty, do not hesitate to contact our technical support.
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Modifications made

2013-07-03
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Minor text corrections

2014-02-28
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CE cetrtificate was replaced by Declaration of
Conformity.

2014-09-23

Fixed I2C memory example picture.

Described new option - Show only the lowest byte of
word in ASCII

2014-11-21

Updated list of variables for up_dil.dll

2014-11-25

New settings of the UP program have been added.

2015-02-03

Added View/Console menu description.

Added description of PIC32MZ_BootProg variable.

Small text fixes.

2015-03-12

The name of item Delay for VDD switching on/off has
been changed

Added description of the checksum settings

2015-04-07

Updated description how to create SVF file for
Lattice.

2015-05-19

Definition of input voltage on pins was added.

Description of w=32 parameter for Windows
messages was added.

2015-08-05

Description of the programmer driver installation has
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